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Section 1:  Permissions 

An agency administrator may or may not have the correct permissions to use this 
feature. The administrator may have limited permissions, for example, he/she can 
affect only certain groups and/or use only certain options (view but not create or 
edit).  

If an agency administrator needs to use this feature and does not have the proper 
permissions, he/she should contact the TTE Global Administrator. 

Also, the administrator should be aware that some of the tasks described in this 
guide can be completed only by Concur. In this case, the client must initiate a 
service request with TTE Global Administrator.  

Section 2:  Overview 

The user administration section of Company Administration is used by Travel, 
Expense, and Request administrators to modify user profiles. The user administration 
page contains the fields used on the Employee Profile form in Expense and/or the 
Travel Preferences fields from Travel. The fields displayed will vary depending on the 
user role selected for the new user.  

NOTE: The User administrator can be restricted from editing his/her own user profile. 
To enable this setting, contact TTE Global Administrator to have the 
appropriate module property updated. 

The User Permissions functionality allows administrators to assign Travel, Expense, 
and Request user roles. This feature is available to users with the Role Administrator 
Expense role or Permissions Administrator role.  

User Administration in Travel, Expense, and Request 

Administering users can now be controlled by the type of user, allowing for 
administrators that can access only Travel users, and administrators that can access 
only Expense, or Request users.  

NOTE: This feature does not prevent the client from administrating all types of users 
at one time under a single role; instead this feature provides an additional 
method of dividing the responsibility of administering users. 

User Administration Related Roles and Access 

The user assigned the Employee Administrator role has access to the User 
Administration menu and access to the Expense and Request-related users and 
functions: 

• Expense/ Request user search 
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• Expense/ Request User role check boxes* 

• Expense/ Request Approver role check boxes* 

• Expense/ Request Settings 

• Primary fields on the user details page 

• Can view users from their assigned employee groups and employee group 
configurations when using the Expense Advanced Filters  

• Can view and optionally edit and register a car on behalf of a user 

• Can be restricted to read-only access for auditing purposes 

* Check boxes can be removed from display to prevent assignment by the 
role – refer to Suppressing Assignment of Roles Using Role Check Boxes in 
User Details in this document for more information. 

The user assigned the User Administration role has access to the User 
Administration menu and access to the Travel-related functions: 

• Travel user search 

• Travel Wizard User role check box 

• Travel Settings  

• Primary fields on the user details page 

• Can view users from all groups unless the Divisional View setting restricts 
them to only employees in groups they are a member of  

• Can be restricted to read-only access for auditing purposes 

TIP: Provide both the Employee Administrator and the User Administration roles for 
administrators that need access to Travel, Expense, and Request users. 

Role Assignment: Access and Related Product Assignments 

When assigning either the Role Administrator or Permissions Administrator roles, 
keep in mind the following logic used by the system to assign the role within other 
modules as well. 

• Role Administrator: A user with the Role Administrator role has access to 
the User Permissions menu and access to the Expense, Request, and 
Reporting tabs. 

♦ ASSIGN: Assign from the Expense, or Request tab. Assigns Role 
Administrator to the specified user, and additionally assigns the 
Permissions Administrator role under Travel. 

♦ REMOVE: Remove from the Expense, or Request tab; removes the role 
from all excepting the Permissions Administrator role under Travel. 

• Permissions Administrator: A user with the Permissions Administrator role 
has access to the User Permissions menu and access to the Travel tab. 

♦ ASSIGN: Assign from the Travel tab. Assigns Permissions Administrator 
to the specified user, Travel only. 
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♦ REMOVE: Remove from the Travel tab. Removes Permissions 
Administrator from the specified user, Travel only. 

TIP: Provide both the Employee Administrator and the User Administration roles for 
administrators that need access to Travel, Expense, and Request users. 

Segregating the User Administration Duties 

Best Practice for user security is to segregate the duties for: 

• Creating users 

• Assigning roles to users 

• Maintaining user roles and preferences 

• Auditing records under read-only roles 

These roles allow segregation of these duties: 

• Employee Administrator/User Admin: Provides access to the User 
Administration function. The user can assign only the basic user roles 
(Expense User, Travel User), using the check boxes in the user details page 
that appears when you open a user for administration. 

TIP: You can have these check boxes removed from display, preventing 
assignment of these roles – see Suppressing Assignment of Roles Using Role 
Check Boxes in User Details in this document for more information. 

• Role Administrator/Permission Admin: Provides access to the User 
Permissions function. 

• User Maintenance/Employee Maintenance (Travel and all else, 
respectively): Provides access to the User Permissions function, but without 
the ability to create a new user account. 

Two Frameworks for User Permissions 

How user permissions are named and managed depends on the module: 

• Permissions: Travel and Meeting related roles are called permissions and are 
managed from the Travel tab in the user permissions section.  

• Roles: Expense, Concur Insight (formerly Analysis/Intelligence), and 
Request-related roles are called roles and are managed from the Expense, 
Request, Reporting tabs in the user permissions section. 

Suppressing Assignment of Roles Using Role Check Boxes in User Details 

The user assignment check boxes can be removed from display to allow tighter 
security control of role assignment, preventing a scenario where approval of a 
substantial amount via a purchase order or expense is granted by way of role 
assignment with intent to defraud. 
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The feature works by suppressing the display of the check boxes. To do this, contact 
the TTE Global Administrator requesting that the Allow User Admin to 
Add/Update Expense Roles Console (HMC) setting be set to No. 

 

Two Methods of Managing Roles in User Permissions 

Roles can be managed by two different methods: 

• By User Name: The administrator searches for the desired user, then selects 
the user and the roles to assign.  

• By Role: The administrator searches for the desired role, then selects the 
users to assign the role to. 

The interface in the user permissions section changes depending on the method 
selected. However, it always contains the following elements: 

• Method selection box 

• Search area 

• User/Role selection box 

• Dual lists of roles or users 

• Group area 
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The Password Manager Roles 

Some clients need a user role that can update user passwords but does not have 
other user administration access. To answer this need, two standard roles are 
available, both called Password Manager. One role is available to clients with Travel, 
and one is available to clients with Expense/ Request.  

Clients with Travel and either Expense/Request can choose how to limit access to 
users by assigning one or both roles: 

• The role on the Travel tab in the user permissions section will grant access to 
the users with the Travel feature enabled. If the Travel settings are set to use 
Divisional Access, the user will only be able to view and update users in their 
divisions. 

• The role on the Expense or Request tab in the user permissions section will 
grant access to the users with Expense or Request enabled. The administrator 
can select the Expense groups (Request uses Expense groups) the user has 
access to when assigning the role.  

• If both roles are assigned, the user will be able to view and update users that 
match their Travel divisional access (if enabled) and selected Expense group 
(Request uses Expense groups).  

NOTE: The users with Travel and either Expense and Request have one password for 
all applications. When any of the Password Manager roles changes a 
password, it changes for all applications. 

Users with these roles will see the Password Manager link on the Company 
Administrator page. These roles have the following access in Password Manager: 

• User search functionality found in the user administration section 

• Modify access to the Password fields on the user details page 

• Read-only access to the Title, First Name, Middle Name, Nickname, Last 
Name, Suffix, and Email fields on the user details page 

All other fields on the user details page are hidden. 

Suppressing Access to the Password Function 

A module property is available that can prevent any password changes within 
Concur. If the property setting is ON, all password fields in Company Admin (User 
Administration or Password Administrator) become non-editable (deactivated): 
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When a new user is added via the import the system provides a randomly generated 
20-character password.  **IS this true in our configuration? 

Section 3:  Available Permissions and Roles 

The following lists contain the available permissions and roles for Expense, Travel, 
and Concur Insight (formerly Analysis/Intelligence). The roles are separated into 
tables based on the tabs in User Permissions. 

Travel Tab 

None of the Travel permissions are assigned along with a group. 
 
Travel Tab  

Permission Description 

Administer Approval 
Queue 

The user assigned this role can reassign approval requests. 
You can assign this permission by itself. 
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Travel Tab  

Permission Description 

Amadeus User The user assigned this role can access AeTM; requires 
Amadeus configuration. 

Billing Administrator The user assigned this role can view bills from Concur. 
You must assign this permission with one other administration 
permission. 

Company 
Administration 

The user assigned this role can access: 
• Administer Approval Queue 
• Billing Administrator 
• Company Locations Administration 
• Group and Shared Resources Administration 
• Managed Meeting Center Admin (ONLY if the Third Party 

Meeting Module has been enabled). 
• Organization Unit Administration 
• Permission Administrator 
• Risk Management Admin (Used with Concur Risk 

Management) 
• Travel Policy Administrator 
• User Administration 

NOTE: When you also select the User Administration 
permission, the User Permissions link becomes available in 
Company Administration. 

Company Discount 
Administrator 

The user assigned this role can add Travel site-level discounts. 
This feature is available to the user when you select this 
permission and the Allow Discount Editing option has been 
enabled in the Company Travel Configuration for the customer 
site. 

 Refer to the Concur Travel: Travel System Admin User 
Guide, Company Travel Configuration, Other Information 
section for additional assistance. 

This permission must be combined with the Travel Policy 
Administrator permission. 

Company Link 
Administrator 

The user assigned this role can manage company-specific 
links. 
Once the permission in assigned, that user can access 
Administration > Company > Company Admin > 
Company Links Administrator. 

Company Locations 
and Maps 

The user assigned this role can enter locations for travelers to 
use when searching for hotels or off-airport car locations. 

Concur Meeting 
Accountant 

The user assigned this role can add credit cards to a meeting 
and download payment files; has access to all Meeting pages. 
NOTE: This permission will appear only if you have enabled 
Meeting via the new site setup work order. 
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Travel Tab  

Permission Description 

Concur Meeting Admin The user assigned this role can access Meeting administration; 
allows Meeting administration with the Concur registration 
module; has access to all Meeting pages except: 
• Travel > Form of Payment 
• Tracking > Payment (the Edit link is hidden from within 

the Payment page) 
NOTE: This permission will appear only if you have enabled 
Meeting via the new site setup work order. 

Concur Meeting 
Planner 

Allows user to access all Meeting pages except: 
• Travel > Agency Settings 
• Travel > Form of Payment 
• Tracking > Payment (the Edit link is hidden from within 

the Payment page) 

Corporate Ghost Card 
Administrator 

The user assigned this role can access to the Corporate 
Ghost Cards link on the Company Administration page. 
NOTE: The Company Groups link and the links in the Group 
Administration section are always present for anyone with 
administrative privileges, but users can only edit (not add) 
groups they own if they do not also have the Group and 
Shared Resources Administration permission. 

Custom Field 
Administrator 

The user assigned this role can access to the Manage 
Custom Fields link on the Company Administration page. 
NOTE: The Company Groups link and the links in the Group 
Administration section are always present for anyone with 
administrative privileges, but users can only edit (not add) 
groups they own if they do not also have the Group and 
Shared Resources Administration permission. 

Employee Maintenance The user assigned this role can manage employees, including 
assigning roles, delegates, and preferences. However, they 
cannot create a new user account. 

 Refer to the User Administration in Travel, Expense, and 
Request section of this guide for more information about 
assigning roles. 

Group and Shared 
Resources 
Administration 

The user assigned this role can view and modify groups. 
You can assign this permission by itself. 
NOTE: If a user owns a group or is in a group that owns a 
group, the user will not be able to modify that group without 
this permission. Ownership of a group provides no additional 
access. 

Guest Booking The user assigned this role can create reservations for non-
profiled travelers. 

Import Data 
Administrator 

The user assigned this role can import data from a customer 
site, instead of logging into the agency site and selecting 
Administration > Travel > Travel System Admin > 
Import Data. 
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Travel Tab  

Permission Description 

Localization Admin / 
Localization user 

Localization Admin is assigned only to Concur employees. 
Localization User is assigned only by a Localization Admin. 

Locate & Alert 
Administrator 

The user assigned this role can access the location information 
and send two-way communications to all enrolled Locate & 
Alert users. 

 For more information about the Locate & Alert service, 
refer to the Locate & Alert User Guide on the Concur 
Support Portal. 

Locate & Alert 
Operator 

The user assigned this role can access the location information 
and send two-way communications to all enrolled Locate & 
Alert users except those marked as "sensitive" (e.g. 
executives and other travelers whose location need to be more 
guarded) 

 Marking a user as "sensitive" is described in Assign Locate 
& Alert User-Level Status in this guide. 

 For more information about the Locate & Alert service, 
refer to the Locate & Alert User Guide on the Concur 
Support portal. 

Manifest Administrator The user assigned this role can manage manifests. 

Meeting Center 
Developer Third Party 

The user assigned this role can test screens and 
documentation for a third-party meeting product with XML 
integration. 
NOTE: This permission appears only if you have enabled 
Meeting via the new site setup work order. 

Online Order Form 
Access 

The user (TMC) assigned this role can allow its agents to 
access to the online order form. 
NOTE: This permission is visible only when the Concur Travel 
Reseller module is given to the TMC by Concur. 

Concur TripLink User The user assigned this role can use TripLink, if that service is 
used by the company. 

Organization Unit 
Administration 

The user assigned this role can create and edit organizational 
units. 
You can assign this permission by itself. 

Password Manager The user assigned this role can update passwords for Travel 
users. 
User will have read only access to the following fields on the 
user details page in User Administration: Title, First Name, 
Middle Name, Nickname, Last Name, Suffix, and Email. 
Preventing Access: A module property is available to restrict 
this role from changing passwords - contact Concur directly to 
have the Password Access Restriction feature activated. 
NOTE: The users with Travel and Expense have one password 
for all applications. When any of the Password Manager roles 
changes a password, it changes for all applications. 
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Travel Tab  

Permission Description 

Permission 
Administrator 

The user assigned this role can access the User Permissions 
menu and the Travel tab. 
NOTE: This role is automatically assigned when the Role 
Administrator role is assigned via Expense and Request. 

Profile Sync 
Administrator 

The user assigned this role can update and retrieve passwords 
from the Profile Sync Configuration page. 

Profile User The user assigned this role can update his/her profile only and 
not have access to the Travel booking wizard. 
NOTE: When a site is created, the 'ALL' group is automatically 
added to the Travel Wizard User permission. You must 
manually remove the 'ALL' group from this permission if you 
do not want travelers to have access to update both their 
profile and make a reservation. 
Make sure the Project team has access to the booking wizard 
for testing purposes by creating another Group for that team, 
and granting the appropriate permissions. 

Report Admin The user assigned this role can define who has access to 
reports. 

 Refer to the Concur Travel: Company Administration User 
Guide for more information on reports and report access.  

You can assign this permission by itself. 

Report User The user assigned this role can view reports. 
You must assign this permission in order for users to view 
company reports; however, you must also assign individual 
reports in the Report Admin.  

 Refer to the Concur Travel: Company Administration User 
Guide for more information on reports and report access.  

You can assign this permission by itself. 

Risk Management 
Admin 

The user assigned this role can use the Concur Risk 
Management feature. 

 Refer to the Authorization Request: Risk Management 
Integration User Guide for more information. 

Self-assigning 
Assistant 

The user assigned this role can assign themselves as an 
assistant. 
If you assign this permission to a user or group, those users 
can select a traveler to assist.  

Self-Registration 
Approver 

The user assigned this role can approve users who self-
register. 

Sponsor The user assigned this role can be assigned as the sponsor for 
the guest user. 
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Travel Tab  

Permission Description 

Travel Agent The user assigned this role can access Expert Agent (XA), if 
you have also assigned the Company Administration 
permission. 
With this permission: 
• The Travel System Admin link may be displayed but will 

only provide data based on the backend setup.  
• The Import Data link will appear within Company 

Administration. 

Travel Meeting Center 
Admin Third Party 

The user assigned this role can use a third-party meeting 
product with XML integration administrator screens; allows 
Meeting administration without the Concur registration 
module. 
NOTE: This permission will appear only if you have enabled 
Meeting via the new site setup work order. 

Travel Meeting Center 
User 

The user assigned this role can access meetings to which 
he/she is invited (this is for both third-party and Meeting 
products). 
NOTE: This permission will appear only if you have enabled 
Meeting via the new site setup work order. 

Travel Policy 
Administrator 

The user assigned this role can administer Travel Policy. 
You can assign this permission by itself.  
Assigning this permission provides access to: 
• Corporate Ghost Cards 
• E-Receipt Admin 
• Travel Admin 
• Travel Rule Builder 
• Travel Reporting 
• Travel Templates (administering for all users) 
• Credit Card BIN Restrictions 
• Unused Tickets 
• Meeting Center Admin 

NOTE: This link appears if you have assigned Meetings 
Admin permission or Travel Meeting Center Admin Third 
Party permission. 

• Manage Corporate Discounts 
NOTE: This link appears if you have assigned both this 
permission and the Company Discount Administrator 
permission. 

Travel Wizard User The user assigned this role can access to the Travel profile and 
Booking Wizard to make online reservations. 
This permission is automatically assigned to ALL (group). 

UI Preview The user assigned this role can preview the enhanced user 
interface.  
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Travel Tab  

Permission Description 

User Administration The user assigned this role can modify and add Travel users. 
Assigning this permission provides access to: 
• Add User 
• User Import 
• Self-Registration Setup 

User Admin (Read 
Only) 

The user assigned this role can view but not modify and add 
Travel users. 

Web Services 
Administrator 

The user assigned this role can register or enable a partner 
application to access the Concur web services.  

 Refer to http://developer.concur.com for more 
information. 

zAuto-Cancel User The user assigned this role can test general functionality in 
Concur Travel. 
Reservations made by users with this permission: 

• Will not have custom PNR finishing remarks added 
• Will not be queued to any queues defined in the Agency 

Configuration 
• Will not show in reports 
• Will be auto-canceled in the GDS after 4 hours 

z_Demo/Training/ 
Practice AeTM User 

The user assigned this role can test the integration between 
AeTM and Expense; requires Amadeus configuration. 
The PNR will never appear in the agency's ticketing queue, 
finishing will not be completed, and will be auto-cancelled by 
the system after four hours. 

zDemo/Training/ 
Practice User 

The user assigned this role can test the integration between 
Concur Travel and other Concur products. 
Reservations made by users with this permission: 

• Will generate “demo” e-tickets and e-receipts 
• Will not have custom PNR finishing remarks added 
• Will not be queued to any queues defined in the Agency 

Configuration 
• Will not show in reports 
• Will be auto-canceled in the GDS after 4 hours 

When applied to a login ID, Concur's standard invoicing 
practices will apply unless you utilize the non-invoiced policies. 
NOTE: In emergency situations, you can use the agent 
claimed remark to prevent bookings made with Z Demo 
permission from being auto-cancelled.  

http://developer.concur.com/
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Expense Tab 
 

Expense Tab   

Role Description Product Area 

Attendee Administrator The user assigned this role can view, modify, 
and activate or inactivate any attendee 
record in the system. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

Expense 

Attendee Administrator 
(Read only) 

The user assigned to this role is considered a 
read-only auditor. The user can access and 
view but not modify and activate or 
inactivate an attendee record in the system. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

Expense 

Authorized Approver This is special approver role, which is not 
assigned the same way as other roles. 

 Refer to the Expense:  Workflow - 
Authorized Approvers Setup Guide. 

Expense 

Budget Administrator The user assigned this role can set budget 
amounts and assign budget approvers. 

 Refer to the Shared: Budget Insight User 
Guide, Expense: Budget Insight Setup 
Guide, and the Authorization Request: 
Budget Insight Setup Guide. 

Shared with 
two or more 
Concur 
products 

Budget Approver The user assigned this role can review and 
approve expense reports using real-time 
budget figures. 

 Refer to the Shared: Budget Insight User 
Guide, Expense: Budget Insight Setup 
Guide, and the Authorization Request: 
Budget Insight Setup Guide. 

Shared with 
two or more 
Concur 
products 

Card Program 
Administrator 

The user assigned this role manages the 
company's purchase card program and 
statement periods. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

Expense 

Central Reconciliation 
Processor 

The user assigned this role processes 
(matches) invoice transactions associated 
with requests generated within the Request 
product.  
Group-aware: When assigning this role, one 
or more groups must be selected. 

Expense 
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Expense Tab   

Role Description Product Area 

Company Bill 
Statement Approver 

The user assigned this role approves 
statement reports. This user must also be 
assigned the Expense Approver role. 

 Refer to the Expense: Company Bill 
Statement Reports Setup Guide. 

Expense 

Company Bill 
Statement Processor  

The user assigned this role views and 
updates statement reports in Expense 
Processor. This user must also be assigned 
the Expense Processor role. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

 Refer to the Expense: Company Bill 
Statement Reports Setup Guide. 

Expense 

Company Bill 
Statement Processor 
(Audit) 

The user assigned this role views statement 
reports in Expense Processor in read-only 
format. This user must also be assigned the 
Expense Processor (Audit) role. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

 Refer to the Expense: Company Bill 
Statement Reports Setup Guide. 

Expense 

Company Bill 
Statement Processor 
Manager 

The user assigned this role views, updates, 
and deletes statement reports in Expense 
Processor. This user must also be assigned 
the Expense Processor Manager role. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

 Refer to the Expense: Company Bill 
Statement Reports Setup Guide. 

Expense 

Company Bill 
Statement User 

The user assigned this role reviews and 
submits the purchasing card transactions in 
the statement reports. This user must also be 
assigned the Expense User role. 

 Refer to the Expense: Company Bill 
Statement Reports Setup Guide. 

Expense 

Company Info 
Administrator 

The user assigned this role can update the 
Company Info section in Profile > Profile 
Settings. 

Shared with 
two or more 
Concur 
products 

Concur Mobile User Do not use; is not associated with 
Concur's mobile app. 

 

Cost Object Approver This is special approver role, which is not 
assigned the same way as other roles. 

 Refer to the Expense:  Workflow – Cost 
Object Approvers Setup Guide. 

Expense 
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Expense Tab   

Role Description Product Area 

Employee 
Administrator 

The user assigned this role can add and 
manage employees, including assigning roles, 
delegates, and preferences.  
The user can only assign the basic user roles 
(Expense User, Travel User), using the check 
boxes on the User Details page. They may 
also view and optionally edit and register cars 
on behalf of a user. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

 Refer to the User Administration in 
Travel, Expense and Request section of 
this guide for more information about 
assigning roles. 

 Refer to Expense: Car Configuration 
Setup Guide for information about 
configuration and managing cars for the 
user. 

Shared with 
two or more 
Concur 
products 

Employee 
Administrator (Read 
Only) 

The user assigned to this role is considered a 
read-only auditor. The user can view but not 
add or edit employee records. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

 Refer to the User Administration in 
Travel, Expense and Request section of 
this guide for more information about 
assigning roles. 

Shared with 
two or more 
Concur 
products 

Employee Maintenance The user assigned this role can manage 
employees, including assigning roles, 
delegates, and preferences. However, they 
cannot create a new user account. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

 Refer to the User Administration in 
Travel, Expense and Request section of 
this guide for more information about 
assigning roles. 

Shared with 
two or more 
Concur 
products 

Expense Approver The user assigned this role can approve 
expense reports within an assigned group. 
NOTE: This approver is also automatically 
assigned as the Travel Approver if the 
employee is a Travel user. 

Expense  

Expense Cash Advance 
Administrator 

The user assigned this role can view, issue, 
and manage cash advance requests. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

Expense 
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Expense Tab   

Role Description Product Area 

Expense Company 
Card Administrator 

The user assigned this role can:  
• Assign and unassign company cards  
• Map expense types to merchant category 

codes  
Group-aware: When assigning this role, one 
or more groups must be selected. 

Expense 

Expense Configuration 
Administrator 

The user assigned this role can fully 
manage (add, edit, delete):  
• Expense group configurations  
• Policies  
• Expense-based forms and fields, 

validations, and vendor lists  
• Expense report and authorized approver 

workflows  
• Audit rules  
• Expense types and expense categories  
• Payment types  
• Account codes and account code 

hierarchy  
• Exceptions  
• Car configuration and reimbursement  
• Receipt handling, including payment hold, 

scan configurations, receipt limits, and 
receipt imaging  

• Email reminders  
• Reimbursement currencies  
• Offline settings  
• Configuration change log (view only)  

Group-aware: When assigning this role, one 
or more groups must be selected. 

Expense 

Expense Configuration 
Administrator 
(Restricted) 

The user assigned this role can fully 
manage (add, edit, delete):  
• Vendor list items  
• Authorized approvers  
• Audit rules  
• Account codes  
• Exceptions  
• Personal and company car rates  
• Receipt handling, including receipt limits, 

payment hold, and scan configurations  
• Email reminders  
• Configuration change log (view only)  

Group-aware: When assigning this role, one 
or more groups must be selected.  

Expense 
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Expense Tab   

Role Description Product Area 

Expense Processor The user assigned this role:  
• Can view and update expense reports 

within Expense Processor  
• Cannot delete expense reports  

The Access for Processor field limits the 
reports the processor can view to these 
options: 
• Display all reports excluding returned 

reports  
• Display all reports including returned 

reports  
• Display only reports pending processor 

step and beyond  
Group-aware: When assigning this role, one 
or more groups must be selected. 
NOTE: The user should only be assigned one 
of the Expense Processor roles. If the user is 
assigned multiple Expense Processor roles, 
the role with the greatest level of access will 
be applied. The levels of access, from highest 
to lowest, are: 
1. Expense Processor Manager 
2. Expense Processor 
3. Expense Processor (Audit) 

Expense 

Expense Processor 
(Audit) 

The user assigned this role:  
• Can view expense reports within Expense 

Processor  
• Cannot update or delete expense reports  

Group-aware: When assigning this role, one 
or more groups must be selected. 
NOTE: The user should only be assigned one 
of the Expense Processor roles. If the user is 
assigned multiple Expense Processor roles, 
the role with the greatest level of access will 
be applied. The levels of access, from highest 
to lowest, are: 
1. Expense Processor Manager 
2. Expense Processor 
3. Expense Processor (Audit) 

Expense 
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Expense Tab   

Role Description Product Area 

Expense Processor 
Manager 

The user assigned this role can view, update, 
and delete expense reports within Expense 
Processor. 
The Access for Processor field limits the 
reports the processor can view to these 
options: 
• Display all reports excluding returned 

reports  
• Display all reports including returned 

reports  
• Display only reports pending processor 

step and beyond  
Group-aware: When assigning this role, one 
or more groups must be selected. 
NOTE: The user should only be assigned one 
of the Expense Processor roles. If the user is 
assigned multiple Expense Processor roles, 
the role with the greatest level of access will 
be applied. The levels of access, from highest 
to lowest, are: 
1. Expense Processor Manager 
2. Expense Processor 
3. Expense Processor (Audit) 

Expense 

Expense Proxy Logon The user assigned this role can log on to 
Expense and act as a proxy user for other 
employees within an assigned group. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

Expense  

Expense Receipt 
Processor 

The user assigned this role can update the 
receipt status for an expense report. 

Expense 

Expense User The user assigned this role can create and 
submit expense reports and cash advances if 
those features are used by the user's 
company. 

Expense  

Extract Administrator Special role assigned by Concur's 
Implementation department to clients who 
are transitioning from the Standard Edition to 
the Professional Edition. 
This role provides access to the File Export 
Configuration tool. 

Expense 

Fringe Benefits Tax 
Administrator 

Along with the Tax Administration role, the 
user assigned this role can manage fringe-
benefit tax. 

Expense 
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Expense Tab   

Role Description Product Area 

Import/Extract 
Administrator 
(formerly Integration 
Administrator) 

A user assigned this role can:  
• Manage (add, edit, delete) import, 

extract, archive, and reporting 
consolidation jobs  

• Schedule jobs  
• View the system log  

Shared with 
two or more 
Concur 
products 

Import/Extract Monitor 
(formerly Integration 
Administrator - 
Restricted) 

A user assigned this role can view:  
• Details of import, extract, archive, and 

reporting consolidation jobs  
• Job schedule  
• System logs  

Depending on configuration, this user may 
also be able to:  
• Upload import files 
• Download extract files 

Shared with 
two or more 
Concur 
products 

Password Manager The user assigned this role can update 
passwords for Expense users. 
User will have read only access to the 
following fields on the User Details page in 
User Administration: Title, First Name, Middle 
Name, Nickname, Last Name, Suffix, and 
Email. 
Preventing Access: A module property is 
available to restrict this role from changing 
passwords - contact Concur directly to have 
the Password Access Restriction feature 
activated. 
NOTES:  
• The users with Expense and Travel have 

one password for all applications. When 
any of the Password Manager roles 
changes a password, it changes for all 
applications. 

• Group-aware: When assigning this role, 
one or more groups must be selected. 

Shared with 
two or more 
Concur 
products 
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Expense Tab   

Role Description Product Area 

Reimbursement 
Auditor 

A user assigned this role can view Expense 
Pay functionality: 
• Funding Accounts 
• Batch Configurations 
• Card Programs 
• Expense Pay Settings 
• Current and Historical Batch List 
• Daily Funding and Returned Amounts 
• Payment Demand List 
• Report Payees List 
• Employee Banking Status 

Shared with 
two or more 
Concur 
products 

Reimbursement 
Manager 

A user assigned this role can fully manage 
(add, edit, delete) Expense Pay functionality: 
• Funding Accounts 
• Batch Configurations 
• Card Programs 
• Expense Pay Settings 

In addition, a user assigned this role can 
view the following Expense Pay details: 
• Current and Historical Batch List 
• Daily Funding and Returned Amounts 
• Payment Demand List 
• Report Payees List 
• Employee Banking Status 

Group-aware: When assigning this role, one 
or more groups must be selected. 

Shared with 
two or more 
Concur 
products 

Role Administrator A user assigned this role is granted access to 
the Expense and Request tabs through 
User Permissions. 
Group-aware: When assigning this role, one 
or more groups must be selected. 

 Refer to the User Administration in 
Travel, Expense, and Request section of 
this guide for more information. 

Shared with 
two or more 
Concur 
products 

Role Builder A user assigned this role can access the Role 
Builder functionality. 

Shared with 
two or more 
Concur 
products 
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Expense Tab   

Role Description Product Area 

Shared Configuration 
Administrator 

The user assigned this role can fully 
manage (add, edit, delete):  
• Feature hierarchies for Expense Reports 

and Vendor Payment Requests  
• Employee group configurations, including 

assignment of the employee form  
• Employee forms and fields, validations, 

and custom and connected lists  
• Expense and payment delegate 

configurations  
• Reimbursement currencies  
• Imaging settings  
• Ledgers  
• Localization tasks  
• Configuration change log (view only)  

Group-aware: When assigning this role, one 
or more groups must be selected. 

Shared with 
two or more 
Concur 
products 

Shared Configuration 
Administrator 
(Restricted) 

The user assigned this role can:  
• View, add, edit, and delete custom list 

items  
• View the configuration change log  

Group-aware: When assigning this role, one 
or more groups must be selected. 

Shared with 
two or more 
Concur 
products 

Tax Administrator The user assigned this role can fully 
manage (add, edit, delete) value added tax 
(VAT):  
• Tax configurations  
• Rates  

Expense 

Training Administrator The user assigned this role can access the 
Training Administration tool to configure 
client-preferred Training landing page and 
the contents and contact information that 
displays. 

Shared with 
two or more 
Concur 
products 

Travel and Expense 
Pilot User 

Do not use - this role is retired.  

Travel and Expense 
User 

The user assigned this role can access 
Concur. The user requires an additional role 
(Expense User, Travel User, etc.) to access 
Concur's products. 

Shared with 
two or more 
Concur 
products 

UI Preview The user assigned this role can preview the 
enhanced user interface.  

Shared with 
two or more 
Concur 
products 
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Expense Tab   

Role Description Product Area 

Web Services 
Administrator 

The user assigned this role can register or 
enable a partner application to access the 
Concur web services.  

 Refer to 
http://www.developer.concur.com for 
more information. 

Concur 
Connect 

Request Tab  
 

Request Tab  

There are several other roles available on the Request tab that are shared with other 
Concur products. For a definition of each, refer to the Expense roles. 

Role Description 

Request Administrator This is one of the Request processor roles. 
The user assigned this role can view and fully manage virtually 
all requests. 
Group-aware: When assigning this role, one or more groups 
must be selected. 

 Refer to the Authorization Request: Processor User Guide. 

Request Approver The user assigned this role can approve requests within his/her 
assigned group. 

Request Auditor This is one of the Request processor roles. 
This is a read-only role. The Concur client can assign this role 
to TMCs, to its own internal travel agent(s), or to any other 
user that needs read-only access to requests. 
Group-aware: When assigning this role, one or more groups 
must be selected. 

 Refer to the Authorization Request: Processor User Guide. 

Request Configuration 
Administrator 

The user assigned this role can fully manage (add, edit, 
delete) all request-related features on the Request Admin 
menu.  
Group-aware: When assigning this role, one or more groups 
must be selected.  

Request Configuration 
Administrator 
(Restricted) 

The user assigned this role can fully manage (add, edit, 
delete):  
• List management 
• Segment types  
• Travel agency offices  

Group-aware: When assigning this role, one or more groups 
must be selected. 

http://www.developer.concur.com/
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Request Tab  

There are several other roles available on the Request tab that are shared with other 
Concur products. For a definition of each, refer to the Expense roles. 

Role Description 

Request Event 
Manager 

The user assigned this role can create a "master" event request 
for multiple event attendees. 
This role must be assigned with the Request Proxy Logon role. 

Request Proxy Logon The user assigned this role can log on to Request and act as a 
proxy user for other employees within an assigned group. 
Group-aware: When assigning this role, one or more groups 
must be selected. 

Request User The user assigned this role can create and submit requests.  

Risk Manager This permission appears only if Request is integrated with 
Concur Risk Management. 
Group-aware: When assigning this role, one or more groups 
must be selected. 

 Refer to the Authorization Request: Risk Management 
Integration User Guide for more information. 

TMC Agent This is one of the Request processor roles. 
The Concur client assigns this role to one or more agents of its 
Travel Management Company (TMC) or to the client's internal 
travel agent(s). In some regions, it is appropriate for the TMC 
Agent to access the request after the user submits it but before 
the approver receives it. This way, the TMC Agent can add/edit 
the segment amounts – ensuring accuracy for the request 
approver. 
Group-aware: When assigning this role, one or more groups 
must be selected. 

 Refer to the Authorization Request: Processor User Guide. 

Reporting Tab 
 

Reporting Tab   

Role Description 

Budget Role for Cognos The user assigned this role can access the Budget module in 
the Concur Insight (formerly Analysis/Intelligence) data 
model. 
Group-aware: When assigning this role, one or more groups 
must be selected. 

CAS Analyst Do not use - this role is retired. 
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Reporting Tab   

Role Description 

Cognos Business Author The user assigned this role:  
• Can use Concur Insight (formerly Analysis/Intelligence) to 

view data for reports submitted at all hierarchical levels 
within their assigned groups (as well as any data not 
group-related)  

• Are assigned the Business license type, which restricts 
the features to which they have access  

• Can:  
♦ Run existing reports 
♦ Create new reports or modify existing  basic reports 

using the basic tool – Query Studio 
Group-aware: When assigning this role, one or more groups 
must be selected. 

Cognos Consumer The user assigned this role:  
• Can use Concur Insight (formerly Analysis/Intelligence) to 

view data for reports submitted at all hierarchical levels 
within their assigned groups (as well as any data not 
group-related)  

• Are assigned the Consumer license type, which further 
restricts the features to which they have access  

• Can run existing reports, with read-only access 
Group-aware: When assigning this role, one or more groups 
must be selected. 

Cognos Professional 
Author 

The user assigned this role:  
• Can use Concur Insight (formerly Analysis/Intelligence) to 

view data for reports submitted at all hierarchical levels 
(no group assignment required)  

• Are assigned the Professional license type, which allows 
access to all features  

• Can: 
♦ Run existing reports 
♦ Create new reports or modify existing  basic reports 

using the basic tool – Query Studio 
♦ Create new reports or modify existing  basic reports 

using the advanced tool – Report Studio 
♦ Schedule automatic report run 

Group-aware: When assigning this role, one or more groups 
must be selected. 
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Reporting Tab   

Role Description 

Consolidation 
Configuration 
Administrator 

This role is used by companies using the Reporting Database 
that wish to consolidate the data from the current version 
and previous versions. 
The user assigned this role:  
• Maps expense types and custom fields to a single 

consolidated definition  
• Can adjust other consolidation settings  

NOTE: This role does not include access to Concur Insight 
(formerly Analysis/Intelligence). 

Dashboard User The user assigned this role can view the Best Practices 
Dashboard. 
NOTE: This role is not associated with any of the Concur 
Insight (formerly Analysis/Intelligence) roles. 

Section 4:  User Administration Page  

This feature requires the User Administrator employee role.  

Before You Begin 

Before using the user administration section, the Employee Profile form must be 
configured.  

Accessing User Admin 

1. Click Administration > Company > Company Admin. 
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2. Click User Administration (left menu).  

 

Searching for Existing Users 

The User administrator can search for existing Travel or Expense users. Users with 
access to both applications will appear in either search. 

Searching for Employees Without Managers 

The Managers field in the search options is used to find employees that do not have 
a manager/approver assigned. 

• When Expense Advanced Filters is selected, the No Manager option in the 
Managers field will cause users who meet all the other search criteria and do 
not have an Expense manager/approver to display.  

• When Travel Advanced Filters is selected, the No Manager option in the 
Managers field will cause users who meet all the other search criteria and do 
not have a Travel manager/approver to display. 

• Select the All Managers option in the Managers field to display users 
regardless of whether they have a manager assigned. 

Searching for Test Users 

The Expense Test Users field in the search options is used to include or exclude 
employees of type Test User if any users of this type exist in the system (that is, it 
will not appear is the system does not detect one or more Test Users).  

• All Users: The filter is ignored, and all test users are returned. 

• Exclude Test Users: Return the search results without including any Test 
Users. 

• Only Test Users: Include only Test Users in the results of the search. 
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 To search for Expense users: 

1. On the user administration page, select (enable) the Show Filters check box 
to view the search fields. 

 

2. Select Use Expense Advanced Filters. 

 

NOTE: The Expense Employee Administrator role is required in order to see 
the Expense search filters. 

3. Enter the search criteria. 



31 | P a g e                T e a m W o r k s  T r a v e l  &  E x p e n s e        Version Date:  09/22/15 
                          S h a r e d  U s e r  A d m i n i s t r a t i o n                   
 

 

4. Select (enable) the check boxes next to the desired columns to display. 

 

5. Click Search. 

 To search for Travel users: 

6. On the user administration page, select (enable) the Show Filters check box 
to view the search fields. 

 

7. Select Use Travel Advanced Filters. 
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8. Enter the search criteria. 

9. Select (enable) the check boxes next to the desired columns to display. 

 

10. Click Search. 

Adding New Users 

New users are added via the HCM import process. Administrators cannot add new 
employees. 

Modifying Existing Users 

Update General Information 

 To update general information: 

11. On the user administration page, locate the desired user. 

 

12. Review the user's information and make any needed updates. 
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NOTE: The role check boxes (Expense User, Expense Approver, etc.) may be 
hidden to prevent assignment by the administrator – consult your TTE 
Global Admininstrator for more information. 

Update Mobile Settings 

 To update mobile settings: 

While editing user information, the Mobile Settings section may appear. 

 

Select the check box as appropriate. 

Note the following: 

• The Remote wipe mobile device check box (in the Mobile Settings 
section) appears only for users who have completed the Mobile Registration 
page (entered a PIN). 

• If an administrator selects this check box, the user's PIN is set to null (blank). 
The next time the user tries to log in, all cached device data is cleared. 

• This flag will also be set automatically by the system if the user enters the 
wrong PIN five times. Consecutive failed attempts are tracked on the device. 
If the user exceeds five, the PIN is set to null (blank) and all cached device 
data is cleared. 
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Add or Change Expense Approvers 

 To add or change approvers: 

1. On the user administration 
page, to add Expense 
approvers, click 
Approvers (in the 
Expense Settings 
section). The Approvers 
window appears. 

NOTE: The cash advance 
approver field will 
only appear if that 
feature has been 
activated for your 
company.  

2. Under Default approver 
for your expense 
reports, type in the 
details of the desired 
approver. The list displays 
possible matches.  

3. Select the desired 
approver. 

4. Click Copy, if desired. 
This will copy the expense report approver into all other approver fields. If the 
approver does not have the appropriate approver roles, the fields will not be 
updated. 

5. Select the other approvers, if desired. 

6. Click Save. 

Add or Change Request Approvers 

 To add or change Request approvers: 

1. On the user administration page, click Request Approvers (in the Request 
Settings section).  

2. Select the desired approver. 

3. Click Save. 
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Add or Change Expense Preferences 

 To add or change Expense preferences: 

1. On the user administration page, click Expense Preferences (in the 
Expense Settings section). The Expense Preferences window appears.  

 

2. Select (enable) or clear (disable) the desired check boxes. 

3. Click Save.  

Add or Change Request Preferences 

 To add or change Request preferences: 

1. On the user administration page, click Request Preferences (in the 
Request Settings section).  

2. Select (enable) or clear (disable) the desired check boxes. 

3. Click Save.  

Add Expense and Request Delegates 

Delegates are shared between Expense and Request. Any additions, deletions, or 
changes you make in Expense will affect Request, and vice versa. 

 To add Expense and Request delegates: 

1. On the user administration page, click Expense Delegates. The Expense 
Delegates window appears.  
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2. Click Add. 

3. In the Search by employee name, email address or logon id field, type 
in the details of the desired delegate. The list displays possible matches. 

 

4. Select the desired delegate and configure as required. 

5. Click Save. 

6. On the user detail page, click Save. 

Add or Change Reimbursement Method *Do we use this?? 

The Reimbursement Method field provides a way for administrators to indicate what 
method the company wants to use to reimburse the employee. The Expense Report 
web service uses this as a search term to find reports with the specified employee 
Reimbursement Method. It does not impact the accounting extracts. It will appear 
only if you have added it to the Employee Form.  

 To add or change Reimbursement Method: 

1. On the user administration page, in the Expense Settings section, select the 
desired value in the Reimbursement Method field. 

2. Click Save.  
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Add Expense Authorized Approvers or Cost Object Approvers 

! IMPORTANT: In order to see the check box or link described below, the user 
must have the User Admin rights and the Expense Admin rights; the employee 
must have the standard approver role. 

EXPENSE AUTHORIZED APPROVER 

If a company uses the authorized approver feature in Expense, based on the 
company's configuration, the company will see one of these methods - never both. 

• Authorized Approver check box 

 

When you select the check box, the Manager Approval Limit field and the 
Approval Limit Currency list appear. Make the appropriate choices and click 
Save. 

NOTE: This method can be used only for limit-based authorized approvers. It 
cannot be used for exception-based authorized approvers.  

• Authorized Approval Limits link 

 

When you click the link, the Authorized Approval Limits window appears. 
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On the left side, select the appropriate level in the hierarchy. 

On the right side: 

♦ For exception-based approvers, select (enable) the Can approve 
exception check box. (The actual exception levels are defined on the 
Authorized Approvers tab in Workflows.) 

♦ For limit-based approvers, select the desired currency and enter the 
amount. 

♦ If an approver has both types of approval authority, define both. 

EXPENSE COST OBJECT APPROVER  

! IMPORTANT: In order to see the link described below, the user must have the 
User Admin rights and the Expense Admin rights; the employee must have the 
standard approver role. 

If the Cost Object Approver feature is activated, the Authorized Approval Limits 
link appears. 
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When you click the link, the Authorized Approval Limits window appears. 

 

On the left side, select the appropriate level in the hierarchy. 

On the right side: 

• For limit-based cost object approval, select a currency and enters an amount. 

• For level-based cost object approval, enter a level. 

NOTE: The cost object configuration defines the type – either limit or level. If you 
complete both areas in this window – the Approval Limit area and the Level field – 
Expense will use the one that applies to your configuration and ignore the other. 

Add Request Authorized Approvers  

! IMPORTANT: In order to see the check box or link described below, the user 
must have the User Admin rights and the Expense Admin rights; the employee 
must have the standard Request approver role. 

If a company uses the authorized approver feature in Request, based on the 
company's configuration, the company will see one of these methods - never both. 

• Authorized Approver check box 
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When you select the check box, the Manager Approval Limit field and the 
Approval Limit Currency list appear. Make the appropriate choices and click 
Save. 

NOTE: This method can be used only for limit-based authorized approvers. It 
cannot be used for exception-based authorized approvers.  

• Authorized Approval Limits link 

 

When you click the link, the Authorized Approval Limits window appears. 

 

On the left side, select the appropriate level in the hierarchy. 

On the right side: 

♦ For exception-based approvers, select (enable) the Can approve 
exception check box. (The actual exception levels are defined on the 
Authorized Approvers tab in Workflows.) 

♦ For limit-based approvers, select the desired currency and enter the 
amount. 

♦ If an approver has both types of approval authority, define both. 
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Assign Locate & Alert User-Level Status 

User Admins assign a Locate & Alert status to each user – effectively enabling or 
disabling Locate & Alert on a per-user basis. The statuses are: 
 

Status Description 

Not Enrolled This user does not use Locate & Alert. 

Enrolled This status is used for most Locate & Alert users. 
This user may be located by and receive alerts from an L&A 
Administrator or an L&A Operator.  

Enrolled 
sensitive user 

Executives and other travelers whose locations need to be more guarded 
would most likely be assigned this status. 
This user may be located by and receive alerts only from an L&A 
Administrator. 

 To assign the user status: 

1. On the user administration page, locate the desired user. 

2. Select the desired status. 

 

3. Click Save. 

Reactivating a User 

The administrator can activate a user that was previously deactivated on the User 
Details page. There are two common requirements: 



42 | P a g e                T e a m W o r k s  T r a v e l  &  E x p e n s e        Version Date:  09/22/15 
                          S h a r e d  U s e r  A d m i n i s t r a t i o n                   
 

 

• The existing user account needs to be reactivated. This means this employee 
will have one user account in Travel & Expense. 

• A new user account needs to be created, using the original login and email 
address but keeping the original, now deactivated user. This means this 
employee will have two user accounts in Travel & Expense. 

 To reactivate a user account: 

1. On the user administration page, locate the desired user. 

 

NOTE: The role check boxes (Expense User, Approver, etc.) may be hidden to 
prevent assignment by the administrator – consult your Concur 
administrator for more information. 

2. Clear the Account Termination Date field.  

A process runs during the Overnight Processing Period that will activate the user. The 
user will be able to log in after the process has run. 

NOTE: You cannot use the Concur Standard Employee Import to reactivate a 
terminated user. Reactivation must be done using the User Administration 
tool. Attempting to reactivate an employee using the Concur Standard Import 
where the imported employee has the same Login ID or Email address as an 
existing terminated user will result in a failure in the import process. Once 
you reactivate the employee using the User Administration tool, you may use 
the Concur Standard Employee Import to make updates to the user's 
information. 

 To create a new user account using the same login and email: 

1. On the user administration page, locate the desired user. 
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NOTE: The role check boxes (Expense User, Approver, etc.) may be hidden to 
prevent assignment by the administrator – consult your Concur 
administrator for more information. 

2. Change the value in the CTE Login Name field. 

3. Change the value in the Email Address field to match. 

4. Click Save.  

5. Create a new user with the desired Login and Email by following the steps in 
the Adding New Users section of this guide. 

NOTE: You may also use the Concur Standard Employee Import to add the user.  
Refer to Chapter 4: Employee Import of Expense – Import and Extract 
Specifications for more information. 

Section 5:  User Permissions 

The User Administrator can assign basic user permissions using the User Role check 
boxes on the user details page. The administrator can assign the full list of 
permissions using the user permissions page.  

Accessing the User Permissions Page 

The user permissions page displays tabs for all configured Concur products, such as 
Travel, or Expense. 
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 To access the user permissions page: 

1. Click Administration > Company > Company Admin. 

2. In the left menu, click User Permissions. 

 

Managing Roles by User Name 

The Permissions administrator can select users by name, then assign or remove the 
available roles. 

 To add a role by user name: 

1. On the user permissions page, in the Modify Roles By list, select User 
Name. 

 

2. In the Search area, enter the desired user's information. Entering one 
letter will cause the system to search for data in the selected fields that 
start with that letter. Entering a comma separated list will search for any 
value in the list. 
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3. Click Search. 

4. In the User Name to Assign Roles field, select the desired user (if there 
is more than one). 

5. Select the desired role(s) in the Available Roles field. You can select 
more than one non-group aware role to assign. Only one group aware role 
can be assigned at a time. 

 

6. If the role is group-aware then the Groups to be Assigned to 
User(s) for the Selected Role(s) list appears.  
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The list defaults with the Global group configuration name. If want to modify 
this, click Modify in the Groups area to select the group that the role applies 
to. The Select Groups window appears.  

 

It lists available group configuration names that can be applied to the role.  
The group configuration can include one or more groups that use the 
configuration. It is the group configuration that actually controls what groups 
this role applies to. 

7. Select the desired group configuration name. 
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8. Click Done. 

9. Click Add to assign the role(s) to the user. 

 To remove a role by user name: 

1. On the user permissions page, in the Modify Roles By list, select User Name. 

2. In the Search area, enter the desired user's information. Entering one letter 
will cause the system to search for data in the selected fields that start with 
that letter. Entering a comma separated list will search for any value in the 
list. 

3. Click Search. This populates the User Name to Assign Roles field. 

4. In the User Name to Assign Roles field, select the desired user. 

5. Select the desired role in the Roles for This User field. 

 

6. Click Remove to remove the role from the user. 

 To change the group assignment for a role: 

The administrator can change the groups that a role is assigned, without removing 
the role.  

1. In the user permissions section, select the desired role.  
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2. Click Modify in the groups area. The group selection window appears: 

 

3. Select the appropriate groups. 

4. Click Done.  

5. Click Modify. 
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6. Click Save. 

Managing Roles by Role 

The Permissions administrator can select roles by name, view all users with the role, 
and assign users to the role. 

 To add a role by role: 

1. In the user permissions section, in the Modify Roles By list, select Role. 

 

2. In the Role to Assign to Users area, select the desired role.  

3. Click Search. The Users without this Role and Users with this Role fields 
are populated. 

4. Select the desired user(s) in the Users without this Role field. More than 
one user can be selected when assigning the role. 
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5. If the role is group-aware then the Groups to be assigned to User(s) for 
the Selected Role(s) list appears. The list defaults with the Global group 
configuration name. If want to modify this, click Modify in the Groups area to 
select the group that the role applies to. The Select Groups window appears. 
It lists available group configuration names that can be applied to the role. 
The group configuration name can include one or more groups that use the 
configuration. It is the group configuration that actually controls what groups 
this role applies to. 

 

6. Select the desired group configuration name. 
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7. Click Done.  

8. Click Add to assign the role to the user. 

 To remove a role by role: 

1. In the user permissions section, in the Modify Roles By list, select Role. 

2. In the Role to Assign to Users field, select the desired role. 

3. Click Search. The Users without this Role and Users with this Role fields 
are populated. 

4. Select the desired user in the Users with this Role field.  

 

5. Click Remove to remove the role from the user. 

 To change the group assignment for a role: 

The administrator can change the groups that a role is assigned, without removing 
the role.  

1. In the user permissions section, select the desired user.  
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2. Click Modify in the groups area. The Select Groups window appears: 

 

3. Select the appropriate groups. 

4. Click Done.  

5. Click Modify. 
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6. Click Save. 
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Section 6:  Viewing a History of Changes Made to an 
Employee 

Reporting on User Changes 

Changes to user details and roles are logged and reportable. You can view the 
history of changes through reports created in Concur Insight Essentials (formerly 
Analysis).  

• To view user detail changes, create a report using the fields in the Expense 
> Lists > Travel Employee History table.  

• To view user role changes, create a report using the fields in the Expense > 
Lists > Employee Role History table.  

Viewing a Report Detailing Changes Made to an Employee 

Changes made to a user, such as password changes or similar, are available by 
running a report in Travel. This option is only available to clients using the integrated 
Travel and Expense solution because it requires administrative access within Travel 
to assign, run, and view the reports. 

Several reports are available: 

• User Profile Changes Version 1: Summary report of changes made at the 
Profile level 

• User Profile Changes Version 2: Detailed report of changes made at the 
Profile level 

• User Preference Changes Version 1: Summary report of changes made at 
the Preference level 

• User Preference Changes Version 2: Detailed report of changes made at 
the Profile level 

Assigning and Running the Reports for Display 

To assign the report, the Travel Report Admin role navigates to Administration > 
Company > Report Admin. They then select how the reports are assigned - via the 
report, specific to a single user, or in bulk by Group.  
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In the figure below, the user is selected and reports assigned to them using the Add 
button: 

 

The user assigned the reports may now run them by navigating to Reporting > 
Travel Reports and selecting a report to run. In the figure below, the Admin 
Password Changes report is selected: 
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Setting the Default Report View 

Open a report and click Show this Report by default to force the next display to 
automatically open to the selected report. In the figure below, the Admin Password 
Changes report is selected for automatic display: 
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 Proxy Logon 

Permissions 
An agency administrator may or may not have the correct permissions to use 
this feature. The administrator may have limited permissions, for example, 
he/she can affect only certain groups and/or use only certain options (view 
but not create or edit).  

If an agency administrator needs to use this feature and does not have the 
proper permissions, he/she should contact the TTE Global Administrator at 
SAO. 

Also, the administrator should be aware that some of the tasks described in 
this guide can be completed only by Concur. In this case, the agency must 
contact the TTE Global Administrator at SAO. 

Overview 
The Expense Proxy Logon tool allows an employee, assigned the role of 
Expense Proxy Logon, to act as a proxy (stand-in) for another employee, to 
perform tasks for either centralized data entry or Helpdesk support. Using 
the Expense Proxy Logon tool, the proxy may sign on to the system as any 
employee that is assigned the role of Expense User. The proxy and the 
employee(s) must belong to the same hierarchical group(s) in order for the 
proxy to perform expense-related tasks on behalf of the employee(s). 

What is an Expense Proxy? 

An Expense Proxy may perform these tasks:  
• Create an expense report and cash advance request 

• View, edit, and delete expense reports 

• Submit an expense report and cash advance request 

• Print an expense report 

• Modify an employee's information within Profile 

The role is restricted to the features and tasks that the employee for whom 
the proxy is acting, can perform. 

NOTE: An Expense Proxy cannot approve reports and payment requests, change 
passwords, or view details of personal cards and personal card charges. 
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Before You Begin 

Before the proxy can work on behalf of another employee, the following steps 
must occur: 

• Employees must be entered into the system by the Employee Import process. 

• The Global and Group Shared Configuration administrators must configure the 
employee groups, within the Group Configurations area of the Shared 
Configuration Administrator. 

• The Global and Group Expense Configuration administrators must configure 
the expense-related and cash advance related groups, within the Group 
Configurations area of the Expense Configuration Administrator. 

• The Employee administrator must assign the Expense Proxy Logon role to the 
employee, and select the hierarchical group(s) for which the employee can 
act.  

 For more information on assigning roles to an employee using User 
Permissions, refer to the Shared: User Administration User Guide. 

What the Employee Administrator Sees 

The Expense Proxy Logon role must be granted to an employee before the 
Expense Proxy Logon tool can be accessed. The Employee administrator uses 
User Permissions to grant this assignment. 
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Proxy Logon Tool 
Multiple employees may be assigned the Expense Proxy Logon role, with 
each employee assigned to all employees within a group or several groups. 
The only limit on who an Expense Proxy can act for is the hierarchical group 
that the proxy is configured to support. 

Accessing the Expense Proxy Logon Tool 

 To access the Expense Proxy Logon tool: 

1. Click Profile.  

 

2. Select the desired user, and click Apply. 

The Profile menu option then becomes Administer for <name> and the 
single "user" icon becomes a double "user" icon. 

 

Creating and Submitting Expense Reports or Cash Advance 
Requests 

As an Expense Proxy, you have the ability to create and submit expense 
reports and cash advance requests for another employee within the 
company. Once you access the employee's account, you will be able to 
perform the following actions:  

• Create expense reports or cash advance requests 

• View, edit, and delete expense reports 
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• Submit expense reports or cash advance requests 

• Print expense reports 

• Modify an employee's information from the Profile area 

Creating an Expense Report or Cash Advance Request  
This process behaves the same as when you create a personal expense 
report or cash advance request. The information appears in the following 
areas, for the employee you are acting on behalf of: 

• The created expense reports appear for the employee you are acting on 
behalf of on the View Reports page. 

• The created cash advance requests appear for the employee you are acting 
on behalf of, on the Cash Advance List page. 

Viewing, Editing, and Deleting Expense Reports or Cash 
Advance Requests  
This process is the same as viewing, editing, and deleting personal expense 
reports or cash advance requests. You will only be able to delete expense 
reports or cash advance requests that have not yet been submitted. 

 If you delete an expense report that has been submitted (even if it was 
recalled) your agency will be charged for that expense report. We encourage 
repurposing expense reports rather than deleting them. 

Submitting or Resubmitting Expense Reports or Cash 
Advance Requests 
This process behaves the same as when you submit or resubmit a personal 
expense report or cash advance request. The information appears in the 
following areas, for the employee you are acting on behalf of: 

• The submitted or resubmitted expense reports appear for the employee you 
are acting on behalf of, on the View Reports page.  

• The submitted or resubmitted cash advance requests appear for the employee 
you are acting on behalf of, on the Cash Advance List page. 

Printing an Expense Report 
This process behaves the same as when you print a personal expense report. 
You have the option to print a Detailed Report or Receipt Report for any of 
the expense reports listed within the employee's View Reports page. 
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Modifying Profile for an Employee 
This process behaves the same as when you modify your own Profile. The 
only differences are that you will be unable to change the password on behalf 
of the employee, and certain fields may be read-only depending on how the 
Shared Configuration administrator configured the fields for the Employee 
form you are viewing. 

Exiting Expense Proxy Logon 

To return to working for himself/herself, the user clicks Administer for 
<name> and then clicks End admin session. 

 

Auditing Proxy Actions 

While an Expense Proxy is acting on behalf of another employee, Expense 
provides a data trail of the actions being performed. The following actions are 
permanently recorded: 

• The name of the person who last modified the expense report, cash advance 
request, or expense 

• The name of the person who submitted the expense report or cash advance 
request, in addition to the time it was submitted 
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Cash Advance Admin 

Section 1:  Permissions 

You may or may not have the correct permissions to use this tool. You may have 
limited permissions, for example, you can affect only certain groups and/or use only 
certain options (view but not create or edit).  

If you need to use this tool, are eligible for the tool and do not have the proper 
permissions, contact the SAO Customer Care Center (404) 657-3956 (888) 896-
7771 or email sao_travel@sao.ga.gov.  

Section 2:  Overview 

Typical Cash Advance Process 

Depending on agency policy, employees may be able to request a cash advance 
before going on a trip or incurring an expense. Requesting a cash advance is 
typically a three-step process: 

1. If an employee is allowed to use cash advances, the employee creates and 
submits the cash advance request in Expense.  

2. Once submitted, the request is routed to the employee's cash advance 
approver. 

NOTE: The cash advance approver may or may not be the employee's 
manager and can be different from the employee's expense report 
approver.  

3. Once approved, the cash advance request is sent to a Cash Advance 
administrator who reviews it and then either issues it or returns the request 
to the user (for example, for more information).  

NOTE: In this case, the term "issue" means final approval in Expense.  

Once the Cash Advance administrator "issues" the cash advance, the company 
disburses the advance to the employee. The employee must create an expense 
report to account for the cash advance within the time specified in the policy in 
effect. 

Note the following about the cash advance workflow: 

• Like Expense, there may be more than one cash advance approver identified 
in a cash advance workflow.  

• Workflow is determined for the agency during the TTE Implementation 
Process. Not all agencies offer Cash (Travel) Advances.  

mailto:sao_travel@sao.ga.gov
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Directly Issued Cash Advances 

The Cash Advance admin can issue a cash advance directly to a user – without 
waiting for the user to submit a request – if the user has a cash advance account 
code assigned. If the Cash Advance feature is not enabled for that user's group, the 
user can utilize the issued cash advance but cannot request any additional advances. 

Receiving Email Notifications of a Cash Advance Pending Issuance 

This feature can be configured so the Cash Advance admin receives emails of 
pending cash advances using Company Admin > User Administration > User 
Permissions. Assign the Expense Cash Advance Administrator role to one or more 
users. On the bottom of that same page (below the group assignment area) select 
(enable) the Send Cash Advance Pending Issuance Emails check box. 

 Refer to the TTE Local Administrator: Shared User Administration Handbook 
for more information. 

 

Section 3:  Cash Advance Admin Tool 

The Cash Advance Admin tool is used by a client user/administrator with the Cash 
Advance Administrator role. With the Cash Advance Admin tool, the administrator 
can: 

• Review cash advance history of employees 

• Issue cash advances 

• Send cash advance requests back to the user (perhaps for more information) 

• Record manually-returned cash amounts from an employee 

• View employee balances 
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Section 4:  Procedures 

Accessing Cash Advance Admin 

 To access Cash Advance Admin: 

1. Click Administration > Company > Tools. 

4. Click Cash Advance Admin (left menu). The Employee Balance tab of the 
Cash Advance Admin page appears. 

 
♦ Use the Employee Balance tab to search for employees with cash 

advances – with or without outstanding balances – and to create and issue 
a cash advance (if configured for your site). 

♦ Use the Cash Advances tab to search for cash advances that have not 
yet been issued. 

Searching for Employees 

You can search for employees using the following parameters: 

• Specific employee information (such as employee name) 

• Oldest Cash Advance Date 
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• Cash Advance Balance 

Employees that match these parameters will appear in the search results, regardless 
of whether they have an outstanding cash advance balance.  

 

Viewing an Employee's Balance and the Cash Advance Details  

 To view cash advance details: 

1. Search for an employee. 

2. Click the name of the employee. The employee's active cash advances appear 
at the bottom of the page. 
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3. Use the Show Only area to change the results. 

 
 

Field Description 

Active Cash Advances All cash advances that are not Cancelled or Completed 

Approved Cash Advances All cash advances with the status of Approved 

Issued Cash Advances Cash advances that have been marked as Issued 

Cancelled Cash Advances All cash advances which you have chosen not to issue 

Completed Cash Advances All cash advances which have been approved, issued, 
fully utilized or returned 

All Cash Advances All cash advances 

4. To view the details, click the desired cash advance name. The cash advance 
opens on the Details tab. 
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The Cash Advance Details tab displays the following fields, based on the 
configured form definition: 
 

Field Description 

Name The name of the cash advance. 

Cash Advance 
Amount  

The amount of the cash advance request. 

Purpose The purpose of the cash advance. 

Exchange Rate The exchange rate at which the cash advance was issued if 
the amount requested was in a currency other than the 
employee's reimbursement currency. 
- OR - 
Provides the default exchange rate to the Cash Advance 
administrator when issuing cash advances in a foreign 
currency 
NOTE: The second option above appears only when the 
Provide Default Exchange Rate for Cash Advance Issuance 
option in Site Settings is enabled. 

Starting Balance The original balance of the cash advance in the employee's 
reimbursement currency. 

Available Balance The unused amount in the employee's reimbursement 
currency. This is based on all submitted reports. 

Travel Start Date The date the user's trip is scheduled to begin. 

Travel End Date The date the user's trip is scheduled to end. 

Requested 
Disbursement Date 

The date that the user requested the funds be disbursed. 

5. View the tabs: 

♦ Comments History: Comments entered by all approvers, the employee, 
and the admin for this cash advance. You can add additional comments to 
a cash advance when you issue or cancel it. The admin cannot add 
comments to a cash advance once it is issued. 

♦ Expenses: Expenses (if any) associated with this cash advance. 

♦ Audit Trail: Activity associated with this cash advance. 

♦ Approval Flow: The cash advance workflow. 

♦ Documents: The images attached to the cash advance. 

 



 

Page | 7                 T e a m W o r k s  T r a v e l  &  E x p e n s e  S y s t e m                Version Date:09/22/2015                         
                       C a s h  A d v a n c e  A d m in i s t r a t i o n                  

 

Issuing or Sending Back a Cash Advance 

Cash advances can be created in two ways: 

• A cash advance request comes from an employee via the normal approval 
process. If a cash advance is requested by an employee, it goes through an 
approval process and then on to the Cash Advance administrator. At that 
time, the admin can issue or send the cash advance back to the employee. 

• A Cash Advance administrator may enter and issue the cash advance directly, 
bypassing the cash advance approval process. The admin can create cash 
advances for users that are in a group that does not have a cash advance 
workflow. The user can utilize the created cash advance but is not able to 
request additional advances. 

 To issue or send back a cash advance: 

NOTE: If there is more than one user with the Expense Cash Advance Administrator 
role, the admin will not be allowed to issue cash advances to himself/herself.  

1. Locate the desired cash advance as described in Viewing an Employee's 
Balance and the Cash Advance Details in this guide. 

2. Select the desired cash advance. 

 

3. Click Issue or Send Back to Employee. 

4. If you clicked Send Back to Employee, the Cash Advance Details page 
appears. Enter a comment, and click Send Back to Employee.  

♦ If you issue the cash advance, the company can now pay the cash to the 
employee. Later, the employee must create an expense report to account 
for the cash. 

♦ If you send the request back to the employee, you must enter a comment. 

Entering and Issuing a Cash Advance in One Step 

The Cash Advance administrator can use options in Employee Balance to search for 
an employee and then create and issue a cash advance on their behalf. This 
bypasses the workflow used for approval when the advance is requested by the user, 
allowing for a simplified process.  
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Creating and Issuing the Cash Advance 

This feature is available only to the Cash Advance admin; the Cash Advance admin 
cannot issue this type of cash advances to himself/herself. 

 To create and issue the cash advance: 

2. The Cash Advance admin uses the Employee Balance tab to search for the 
desired employee. 

 

3. With the employee selected, click Create & Issue: 

 

4. The Create a New Cash Advance window opens. The administrator then 
names the advance, specifies the amount and currency, and adds a purpose 
and comment as needed: 
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5. Click Issue to issue the cash advance. 

Searching for Cash Advances 

The Cash Advance admin can search for cash advances on the Cash Advance tab 
by: 

• Cash advance name  

• Employee first or last name 

• Request date 

• Amount requested 

• Requested disbursement date 

• Start or end date 

• Account code 

• Cash advance key 

• Group  

• Cash advance status 
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 To search for and view a cash advance: 

6. On the Cash Advances tab, enter search criteria. 

7. Click Search. The search results appear in the bottom pane. 

 

8. Click the name of the desired cash advance. The cash advance opens to the 
Details tab. 

 

 For more information on the details page, refer to Viewing an 
Employee's Balance and the Cash Advance Details in this guide. 
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Section 1: Who can Access Reporting  
This document presents an overview of reports customized by the State of Georgia 
Accounting Office.  

The primary TTE Local Travel Administrator is granted permission to access TTE System 
Reports. If the TTE Local Travel Administrator does not have the proper permissions, he/she 
should contact the GA Travel Global Administrator through the Customer Service Center 
[404-657-3956 Option 9, or 1-888-896-7771 (Option 9) or email sao_travel@sao.ga.gov]. 

Access is restricted to data for your agency. Agencies cannot create new reports or modify 
existing reports. Questions, issues or requests for reporting changes should be referred to 
the Customer Service Center [404-657-3956 Option 9, or 1-888-896-7771 (Option 9) or 
email sao_travel@sao.ga.gov]. 

Section 2: Reporting  

Accessing the Reporting Tool 

The Reporting tool is accessed from My Concur. 

1. Log in to Concur. Click on the Reporting tab.  

 

2. The Public Folders tab opens. Click on State Accounting Office.  

 

Accessing SAO Custom Reports   

1. Select State Accounting Office in the Public Folders tab. 

mailto:sao_travel@sao.ga.gov
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2. A list of reports customized for State of Georgia appears.  

 

 

Running SAO Custom Reports   

 
1. Choose a report by clicking on the name listed. 

 

 

2. Prompts for criteria selection may appear depending on the report selected. Enter 
the appropriate requested information for the prompts and click OK or Finish. 
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3. The report displays according to the default output selection.  

 

4. Click the  icon to return to the Report Listing. 
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Changing the output format of an open report 

1. With the report open click on the current format icon 

 

2. Select the new format desired from the drop down list. Note: You may have 
to hold down the Ctrl key when opening a report in Excel. 

 

Create a Shortcut to a Report in My Folders  

1. With the report open click on the drop down arrow next to the Add this report icon  

 

 

2. Select the Add to My Folders option. 

 

3. Specify a name and description for the shortcut. You can also add information about 
the report in the Description field as well as add a screen tip for this report. 
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4. Click Finish. 

Save Report View or Email Copy of A Report  

1. With the report open click on the drop down arrow next to the Keep this version 

icon . 

2. Select Email Report, Save Report or Save as Report View     

 

 

3. If you selected Email Report the Email Options dialogue box opens: 
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a. Enter the email address of the recipients 
b. The subject defaults to the report name. 
c. Use the Body: section to add a note to the email. 
d. Click OK. 

 
4. If you selected Save this report as a view the Save as a report view dialog box 

opens. 
 

 
 

a. Enter a name for the Report View 
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b. Select a location for the report 
i. Use Select My Folders to add the view to your My Folders or Select 

another location to save to a an existing folder or add a new folder 
in My Folders.. 

 

 
 
 

To View Saved Report Views 

1. Click on the My Folders tab. 

 

2. Select the Report View or Sub-Folder that contains the Report View you wish to 
review.  

3. Click on the Report View  
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4. The report will display in the format you have defaulted. 

 

Creating Excel output from a Concur Report  

1. Locate the report you wish to export to Excel and click on the Run with Options 
icon  next to the report you want to run.  

 

 

2. The  Run with options menu appears. 
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3. Click on the dropdown arrow in the Format field and select the Delimited text 
(CSV) report format type and click Run. 

 

 

4. Enter any prompts required for the report you have chosen and click on Finish. 

5. The system will provide information on retrieving your report and your browser 
will give you access to the report. 

a. Click on the Excel report name that displays to open the report in Excel. We 
used Google Chrome so the report name appears at the bottom; the location 
of the report on your screen is browser dependent. 

b. Click on the drop down arrow to access additional options 
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c. Save the report in a location of your choice (outside of TTE-Concur).  

 

Section 3: Setting Preferences 

Override Default Number of Reports in a list View: 
1. Log into Concur and select the Reporting tab. 
2. Select State Accounting Office. 
3. Scroll to the far right of the window. 

 

 

4. In the Entries boxes you can override the default number range of reports you 
want to display on a single page in list view. 
a. Enter 1 in the first box 
b. Enter a number (i.e., 20) in the second box 

c. Click  to make the change. 
i. NOTE: If you want to list to always display a specific range of reports 

such as 3 through 9, enter 3 and then 9 in the second box. Viewing in 
display mode does not use this field.  

d. To set the default number, see Set Personal Preferences. 

5. To access any reports in excess of the preferred number use the double arrows to 
move forward or backward a single page or the arrow and line to go to the first 
or last page of the list. 
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Set Personal Preferences    
1. Log into Concur and select the Reporting tab. 
2. Select State Accounting Office. 
3. Scroll to the far right of the window and click on the down arrow next to the 

 icon. 

 

 

4. Click on My Preferences. 

The General tab opens to display your default options for the State 
Accounting Office folder. 
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i. Number of entries in List View: Set the default number of reports 
you want to display on a screen when viewing reports in the list view.  

ii. Report Format: Click on the down arrow and select your default  
report output preference 

1. HTML – display on screen 
2. PDF – PDF formatted output 
3. Excel 2007 – Excel 2007 formatted output 
4. Excel 2007 Data – Excel 2007 unformatted output 
5. Excel 2002 – Excel 2002 formatted output 
6. Delimited text – CSV format output 
7. XML – XML formatted output 

iii. Separators in list view – click on the dropdown for options 
iv. Portal:  

1. Default view: Select the view your prefer – list or details 
v. Regional Options, Time Zones – defaulted options should be fine 
vi. Click OK. 

 
b. Click on the Personal tab. 
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i. Email: enter the email address you want the system to use for 

notification of new versions. 
ii. Click OK. 

Switch from List to Details view 

1. Click on the Details view icon .  
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Section 4: Custom Reports Catalog  

Report Short Description 

196060 Extracted 
Reconciliation  

Shows all AirPlus (196060 account) detail extracted to TeamWorks by 
date range. 

196060 Pending Transactions Shows all AirPlus (196060) detail NOT extracted to TeamWorks. 

196060 Unassigned 
Transactions 

Shows transactions with missing data such as a Record Locator Number, 
Business Unit, or Employee which prevent the transaction from 
processing. 

196061 AirPlus Invoice 
Reconciliation (Details) 

Gives details on Airfare and Travel Agent fees which are included in the 
AirPlus bill including the program.  For invoice reconciliation. Helpful for 
agencies with attached agencies to identify which attached agency an 
employee belongs to. 

Adoption (Air, Car, Hotel) Tracks number of Concur booked trips vs. number of trips booked 
through the agent at a higher fee. 

Airfare Booked But Not Yet 
Expensed 

Shows users what airline tickets have not yet been expensed. This will 
allow finance departments to identify liabilities and plan appropriately. 

Airfare Expensed Not Booked in 
Concur Travel 

Shows users airline expenses not booked through Concur Travel. 

Airfare Expensed Not Booked in 
Concur Travel (detail) 

Shows users airline expenses not booked through Concur Travel with 
added detail. 

Approval Workflow - Details Shows details of approval workflow by Manager or Process with 
employee details 

Approved Travel Requests by 
Employee Details 

Report in progress. See Global Travel Administrator. 

Attendee Details 

Shows the spending by employees and attendee information for 
expenses that have associated attendees, typically for meal or 
entertainment expense types. This report can be run to provide the total 
picture or for a selected set of expense reports that represent money 
being spent by an employee to cover expenses for fellow employees or 
non-employee clients or prospective clients. 

Authorized Approver List Shows designated authorized approvers with their agency group. 

Billed Transaction 
Reconciliation – Detail 
(Calendar Month) with Program 

Concur transactions by month included deleted expense reports. See 
Global Administrator for more detail. 
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Car Expense Entry Analysis  
Run by selected date range by employee or expense type and options 
for subtotals and all or selected employees. Select specific car related 
expenses. 

Car Rental Details  
Shows detail of Car Rentals by car rental date range and includes 
vendor, record locator, employee detail including email address and 
other relevant data. 

Car Rental Expensed Not 
Booked in Concur Travel 
(Details) 

Date range option and shows detail of Car Rental Expenses not booked 
through Travel. Includes City/Location and no subtotals. 

Cash Advance Analysis w/Aging 
Shows the amount and status of cash advances by employee and issue 
data, including any returned amount with days outstanding aged from 
issue date. 

Completed Travel Requests 
Without Expense Reports  

Shows Requests not attached to Expense Reports  

Detail Report – Extracted (sent 
for payment date) 

For a specified date range, this report includes chart-field details for 
expense reports extracted to TeamWorks including date release by Back 
Office and Concur Extract dates. This report runs by Date Submitted for 
Payment. This report is used for reconciling AP and GL data extracted 
from TTE into TeamWorks. 

Detail Report- Non-Extracted This report includes ALL chart-field details for expense reports NOT 
extracted to TeamWorks. 

Detail Report- Non-Extracted 
(Email) 

This report includes ALL chart-field details for expense reports NOT 
extracted to TeamWorks and includes email address.. 

Detail Report-Submitted (for 
Concur Bill) 

Chart field details by date range for submitted Expense Reports for 
Concur Invoice Reconciliation. Concur billings cut off is 5 days prior to 
the last day of the month. 

Employee Distribution Lines 
(for Concur Bill) 

Provides Chart field details for employee defaults for deleted Expense 
Reports. (Relates to the Detail Report-Submitted) 

Employee Exceptions - Details Id all report level exceptions by employee for date range specified. 

Excessive Personal Car Mileage 
(Extracted Date) 

Run by selected date range with prompts for distance units, flexible 
break even distance and options for all or selected employees with the 
date extracted for payment. 

Expense Entry Analysis Details 
(grouped by employee) 

Run by selected date submitted for payment range with options for all 
or selected expense types, all or selected employees and options for 
specified approval amount range or for highest to lowest amount. 

Expense Reports by Business 
Unit (Concur Invoice Recon) 

Includes a listing of reports submitted by individual by day along with 
the related transaction fee.  Developed to be used in Concur invoice 
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reconciliation.  This report does not include deleted reports and may not 
reconcile 100% with Concur bill. 

Expense Summary Expense summary by expense type run by selected date submitted for 
payment range. 

Expense Summary by 
Employee and Year This report shows summary of expenses by employee and year. 

Extracted Reports (Employee 
vs. Company Paid) Detail 
Report 1 

Reports extracted to TeamWorks by employee, with total amount and 
extracted date, grouped and sub-totaled by payment type: AirPlus, 
Company Paid, and Out of Pocket with added detail of Record Locator 
Number and Ticket ID 

Extracted Reports w/detail 
Run by date range displaying expense report data such as employee, 
payment status, the total amount, sent for payment date and extracted 
date and time. 

Hotel Expense Entry Analysis 
Run by selected date range by employee or expense type and options 
for subtotals and all or selected employees. Select specific hotel 
expenses. 

Hotel Stays Expensed Not 
Booked in Concur Travel 
(Details) 

Shows hotel expenses with no matching reservation in Concur Travel. 

IRS Report w/detail Identifies if employee has any taxable expense reports 

Mileage over 100 Per Day Shows reports with average mileage expense reimbursements over 100 
miles per day. 

Report View of 196060 
Unassigned Transactions Shows unassigned credit card transactions. 

Reports by Approver List of approved expense reports sorted by approver. 

Reports by Approver – 
Delegated 

List of approved expense reports processed by a delegate sorted by 
approver. 

Top 10 Longest to Approve Ranks and shows approvers who took the longest to approve 
transactions by date range 

Top Spend By Airline Ranks by airline costs for airline tickets with subtotals by agency in a 
date range. 

Top Spend By Rental Car 
Company  

Ranks by rental car company costs rentals with subtotals by agency in a 
date range. 
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Top Spend by Vendor Ranks vendors with the highest amount of submitted expenses during a 
specified timeframe. 

Top Spenders  by Employee  This report lists of employees with the highest amount of posted entries. 

Top Spenders by Expense Type This report lists employees with the highest amount of submitted 
expenses within expense types during a specified timeframe. 

Travel Policy Exceptions Details travel policy exceptions including segment type, booked date, 
travel date, days booked in advance, exception code and description 

TTE Cash Advance Analysis Run by date range, with options for payment type, status and all or 
selected employees. 

Unassigned CC & Itineraries 

This report contains two tabs:  
• Unassigned Credit Cards_1 (credit card transactions not 

assigned to an expense report), 
• Unassigned Itineraries_2 (travel itineraries not assigned to an 

expense report) 

Unsubmitted Expense Entry 
Analysis Details (Grouped by 
Employee) 

This report shows a list of expenses grouped by employee that have 
been entered on expense reports but not submitted during a specified 
timeframe. 

Unsubmitted Expense Reports  Sorts the list of unsubmitted expense reports from oldest to newest, 
with amount. 

Unsubmitted Expense Reports 
with Cash Advances  

Sorts the list of unsubmitted expense reports from oldest to newest, 
with amount and any attached Cash Advances  

User Concur Travel History Includes a list of travel reservations booked in Concur travel during 
specified dates. 

Voided Air Tickets  Shows voided tickets; date range and other options available. 

Workflow Cycle Times–Details  
Options of date range and Manager or Processor with options for all or 
specific approvers/processors to show workflow process details and 
performance. Does not include Org Unit or Trip End Date. 

Section 5: TeamWorks Financial Reports 

GL Reports:  

GLXXX0902 GL Offline Travel Interface 
Report 

The Local Travel Administrators will 
need to review the GLXXX0902 (GL 
Offline Interface) report daily to 
ensure all transactions have posted 
into TeamWorks.  This report will 
provide General Ledger Journal 
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Entries created for Company Paid 
transactions that were extracted 
from Concur.   

AP Reports  
APXXX0401  Budget Exceptions This report lists vouchers and 

provides an error description of 
each voucher line that did not pass 
budget checking. 

APXXX0402  Daily Input Report This report lists vouchers that were 
processed through AP including 
regular vouchers, PO vouchers, 
Labor, Payroll and regular offline 
transactions. 

APXXX0404  Payables Due Proof Report This report lists payables selected 
for payment based on the vouchers 
scheduled due date. 

APXXX0408  Payment Activity Report This report lists detailed payment 
information sorted by Voucher ID 
for system checks, manual checks, 
express checks, EFT payments, and 
wire transfers. 

APXXX0419  Travel Expense Report This report lists vouchers for Travel 
Payments. Monthly report will be 
produced automatically at each 
month-end close. 

APXXX0855  Offline Travel Voucher 
Interface Report 

This report will provide Accounts 
Payable vouchers created for 
employee travel reimbursements 
that were extracted from Concur. 

 

Section 6: How to Edit TTE Vouchers in TeamWorks 
Financials 
After the nightly data extract from TTE and the file is import into TeamWorks completes, the 
system runs a Voucher Build. On that day you have the ability to edit the vouchers created 
from TTE transactions. 

Step 1: Access the Query Viewer 

TW Navigation: Reporting Tools> Query>Query Viewer 
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Step 2: Run  Query 0AP042A_VCHRS_NOT_POSTED_DISTR  in TeamWorks Financials  
(This query will show all transactions extracted from TTE on the prior day) 
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Step 3: 
Enter the Agency’s Business Unit. 
Enter the Accounting Date From = day after extraction from TTE 
Enter Accounting Date To = date after extraction from TTE 

For our Example: TTE transaction extracted for business day 06/13/13; Extract processed 
in TW 06/14/13 
Agency Business Unit:   42700 
Accounting Date From: 06/14/2013  
Accounting Date To:  06/14/2013  

 

 

Step 4: 
Once the query runs in Excel, filer:  Origin “TRV”. The query will show all travel payments 
extracted the prior day. 
 
Agencies may review any of the vouchers listed and edit invoice information, payment 
information, or place vouchers on hold. 

 

Section 7: Travel Payments and Reconciliation  

Rental Cars 

Suggested TTE Reports to Run: 

• Car Rental Detail Report 1 (includes Record Locator #) 
• Car Rental Expensed Not Booked in Concur Travel 
• Car Rental Expenses Not Booked in Concur Travel (Details) – includes City/Location 

field and no subtotals 
• Unassigned CC & Itineraries – includes 2 tabs (Unassigned Credit Cards_1 (credit card 

transactions not assigned to an expense report) and Unassigned Itineraries_2 (travel itineraries not 
assigned to an expense report) 

When a traveler books a rental car using TTE, and then imports the transaction into an 
expense report, the payment type for the car rental defaults to “company paid” and no out of 
pocket expense is incurred by the employee. However, the employee is required to include 
this expense on his/her travel expense statement in TTE even though the employee is not 
being reimbursed for the charge.   
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When the travel expense statement is approved and extracted to TeamWorks nightly, the 
following accounting entries occur in the General Ledger module: 

Debit 640XXX – Travel – Rental Car 
• 640006 Travel – In State Rental Car 
• 640025 Travel – Out of State Rental Car 
• 640039 Travel – International Rental Car 

Credit 200006 – Travel Clearing Account - Direct Bill (Rental Car). 

Each agency receives an invoice from the rental car company directly. (Hertz and Enterprise 
are the current State contracted vendors). When the agency pays the invoice in TeamWorks, 
the agency should use the following as the expense account for payment: 

Debit 200006 – Travel Clearing Account - Direct Bill (Rental Car) 

Please note that if an employee rents a vehicle from Hertz at Capitol Hill, the refuel card 
charges will be included. The employee will need to itemize the expense on his expense report. 
The rental portion will be reflected in 640XXX and the fuel charge in the Rental Car Fuel and 
the grand total to 200006.  

In the above scenario, the expense is properly recorded and the clearing account balance for 
the transactions is zero.  Each agency should be monitoring their rental car expenditures and 
reconciling their clearing account quarterly (at a minimum) to ensure that: 

• Employees are filing their expense reports for rental cars timely 
• All invoices being paid are coded properly 
• Balances in the clearing account are justified 

Please note that any reservations made outside the TTE system will not follow the same 
accounting entries as what is described above.  Rental Car Reservations made outside the 
TTE system will result in the invoice being coded to the appropriate travel account, directly, 
and not the 200006 account. 

Direct Bill Hotels 

Suggested TTE Reports to Run: 

• Hotel Expense Entry Analysis 
• Hotel Stays Expensed Not Booked in Concur Travel (Details) 
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• Unassigned CC & Itineraries – includes 2 tabs (Unassigned Credit Cards_1 (credit card 
transactions not assigned to an expense report) and Unassigned Itineraries_2 (travel itineraries not 
assigned to an expense report) 

Although Direct Bill Hotels are not reserved through TTE and the employee is not being 
reimbursed for the Direct Bill Hotel, the traveler is required to manually enter the hotel 
expense in the expense report, deselect the Travel Allowance option, adjust the payment type 
to “Company Paid” and itemize the expense. 

 

 

When the travel expense statement is approved and extracted to TeamWorks nightly, the 
following accounting entries occur in the General Ledger module: 

Debit 640XXX – Travel – Hotel 
• 640003 Travel – In State Hotel  
• 640022 Travel – Out of State Hotel  
• 640036 Travel – International Hotel  

Credit 196040 – Clearing Account – Hotel Direct Bill (Distributed) 

NOTE: Effective 12/01/15 Direct Bill Hotels no longer clear through 200006 

Please note that if there are any taxes itemized for the hotel stay (such as the Georgia 
Transportation Bill Tax of $5 per night) they will be debited to the appropriate account and 
also be included in the total for 196040 when the employee itemizes the expense. 

Each agency receives an invoice from the hotel directly. When the agency pays the invoice in 
TeamWorks, the agency should use the following as the expense account for payment: 

Debit 196041 –Clearing Account – Hotel Direct Bill (Undistributed)  

NOTE: Effective 12/01/15 Direct Bill Hotels no longer clear through 200006 

In the above scenario, the expense is properly recorded and the 196040 and 196041 clearing 
accounts net to zero.  Each agency should be monitoring their direct bill hotel expenditures 
and reconciling their clearing account quarterly (at a minimum) to ensure that: 

• Employees are filing their expense reports for direct bill hotels timely 
• All invoices being paid are coded properly 
• Balances in the clearing account are justified 
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AirPlus (Airfare) 

When a traveler books airfare using TTE, the payment type for the airfare is “company paid.” 
The employee is required to include this expense on his/her travel expense statement in TTE 
even though the employee is not being reimbursed for the charge.   

When the travel expense statement is extracted to TeamWorks nightly, the following 
accounting entries occur in the General Ledger module: 

Debit 640XXX – Travel – Commercial Transportation 
• 640005 Travel – In State Commercial Transportation 
• 640024 Travel – Out of State Commercial Transportation 
• 640038 Travel – International Commercial Transportation 

Credit 196060 – Travel Clearing Account (Distributed) 

The State Accounting Office (SAO) receives a consolidated invoice from AirPlus and is 
responsible for paying AirPlus on behalf of the TTE agencies.  The AirPlus invoice includes 
charges for airfare, as well as all fees assessed by the travel agency (Travel Incorporated) for 
any reservation made using the TTE system. When SAO pays the invoice in TeamWorks, A/P 
vouchers are set up for each impacted agency and A/P vouchers are coded as follows: 

Debit 196061 – Travel Clearing Account (Undistributed) 

SAO uses default chart field information including Department, Program, Fund, Funding 
Source, and Project that is supplied by the agency during the TTE onboarding process.   

Each impacted agency receives a copy of the AirPlus invoice, along with supporting 
documentation for their files.   

In the above scenario, the expense is properly recorded and the clearing accounts (196060 
and 196061) should net to zero.  Each agency should be monitoring their airfare expenditures 
and reconciling their clearing accounts quarterly (at a minimum) to ensure that: 

• Employees are filing their expense reports for airfare timely  
• Balances in the clearing accounts can be justified 

TTE/Concur 

SAO receives a consolidated invoice from Concur monthly and is responsible for paying Concur 
on behalf of the TTE agencies.  The Concur invoice includes fees for each expense report 
submitted at least once in Concur.  

Contractually, expense report fees are initiated the first time an expense report is submitted 
by the employee.  We encourage you to suggest that expense reports not be deleted if it has 
been submitted by an employee at all, but rather that they edit and reused the report as the 
process fee is assessed on the initial submission and will not be credited by Concur due to 
deletion. Again, the report process fee is triggered once at the moment the initial Submit is 
elected by the employee. 

Concur also invoices a separate line item for “select access fees” for specific airline access. 
This is a contractual process fee and is in addition to the expense report process fee.  This 
fee is not assessed by the airlines but by Concur.  
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  When SAO pays the invoice in TeamWorks, A/P vouchers are set up for each impacted 
agency and A/P vouchers are coded as follows: 

Debit 651010 – Per Diem & Fees – Other Fees 

SAO uses default chart field information including Department, Program, Fund, Funding 
Source, and Project that is supplied by the agency during the TTE onboarding process.  
Agencies are authorized to enter Adjustment Vouchers, as needed, if an agency desires to 
reallocate expenditures for Concur. 

Each impacted agency receives a copy of the Concur invoice, along with supporting 
documentation for their files.  

Queries and Reports 

Agencies can run the following queries in TeamWorks to assist with the reconciliation process: 

• 0AP005 – VERIFY_EXP 
• 0GL076 – 4092X GG REPORT 

Agencies can run the following report in Concur to assist with the reconciliation process: 

• 196060 Extracted Reconciliation 

Agencies can also use the AirPlus and Concur supporting documentation (provided by SAO) 
to assist with the reconciliation process. 

Reconciling Transactions Extracted from TTE into TeamWorks 

Document Direct Reports and the TTE Detail Report – Extracted (sent for payment date) to 
Reconcile Accounts 

1. Run the Detail Report- Extracted (sent for payment date) from Reporting in 
Concur.  

Enter the business date or date range you want to reconcile. The Date Sent for Payment is 
the date the Back Office releases the items for payment. The Extracted Date is the date 
TTE/Concur extracted the data to make it available for processing into TeamWorks. 

TTE Entries cut off at 6pm daily. Any transaction after 6pm will not be extracted by TTE until 
the next business day. 

The report date shown in Document Direct represents the date the items were processed by 
SAO and not the date the transactions were released or extracted from TTE. Most times 
there is a one business day lag between the Date Extracted in TTE and the Document Direct 
report date. There can be exceptions.  

• Although TTE extracts data daily, SAO does not process any data on holidays 
or weekends 

o The SAO process for Document Direct documents runs 
between 7am and 10am Monday through Friday except for 
Holidays. 

• The Sent for Payment Date and the Extracted Date may not be the same in 
the Detail Report-Extracted (sent for payment date). 
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• The Document Direct report date will generally be the next business day after 
the Extracted Date in the TTE Detail Report-Extracted (sent for payment date) 
if no holiday was involved. 

o TTE data from Friday’s activity would usually have a Monday 
date in Document Direct as long as Monday was not a holiday 
and would also contain any Saturday through Sunday data 
extracted by TTE. 

o Data from Friday, when Monday is a holiday, would have a 
Tuesday report date in Document Direct and would also 
contain any Saturday through Monday TTE data extracted by 
TTE. 

o IF SAO is closed for any reason during the normal work week 
data is processed the next business day and reports would 
have that business date.  

o On very rare occasions the Document Direct report date can 
be the same as the Extracted Date in the TTE report. 

The Detail Report-Extracted (sent for payment) as displayed in TTE Reporting does not have 
subtotals or grand totals.  

 

View the report in Excel by clicking on the  icon and selecting the appropriate Excel 
options. 
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Save the report to your PC or Laptop with the appropriate date. 

2. Obtain Document Direct GLXXX0902 and APXXX0855 reports  

Open the GLXXX0902 (GL Offline Travel Interface-General Ledger Report) for a specific 
date from Document Direct.  
 
Print or export the report. Then do the same with the APXXX0855 (Offline Travel Voucher 
Interface – Accounts Payable Report). 

 Note: XXX=Agency Business unit number, 404, 419, 427, etc. 

You may Print or Export these reports in Document Direct by selecting File. 

Note: Generally the Print function should be fine. 

 

Document Direct - Print or Export option 

• Select the Print or Export Option 
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 Note: A document must be open or the Print and Export functions are grayed out 
and not available. 

o To Print the report: 
 Select Print 
 Verify the Copies and Pages options 

 
 

 Click OK or select Setup to use a different printer 
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 Choose the desired printer 
 Click OK 
 Click OK again to print 

o To Export the report: 
 Select Export 
 Verify the Pages option. If in doubt, select All to ensure you export the 

entire report. 
 Specify the location to export to in Filename: and alter the name of the 

document if desired.   

 

Note: Document Direct exports documents with the file extension .RPT 

To manipulate the exported data, import it into Excel. 

• Open Excel and then select the GLXXX0902.rpt or APXXX0855.rpt report from the 
saved location. 



31 | P a g e      T e a m W o r k s  T r a v e l  &  E x p e n s e          Revision Date:  11/19/2015 
                                               State of Georgia 

                    

 Note: XXX= Agency Business Unit Number 404, 419, 427, etc. 

 

• The documents exported from Document Direct will have an extension of RPT. 

Example Excel Import process when APXXX0855.rpt (Offline Travel Voucher 
Interface – Accounts Payable) is selected 

• Click on the report to open the Text Import Wizard 

 

• Click Next 



32 | P a g e      T e a m W o r k s  T r a v e l  &  E x p e n s e          Revision Date:  11/19/2015 
                                               State of Georgia 

                    

 

• Click Finish. 

The data imports into Excel and you can manipulate the data as you need. You have the full 
functionality of Excel once the report is in Excel. 

Note: If there is a large amount of data you will see sections for page headers, you 
can simply delete these lines in Excel to make working with the data easier. 
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Note the Total of the vouchers created. In this example it is $1,508.17 which represents the 
total of the AP Vouchers created from the TTE/Concur Extract. 

Example Excel Import process when GLXXX0902 - GL Offline Travel 
Interface/General Ledger Report is selected: 

• The Text Import Wizard – Step 1 opens. 
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• You can start the import at row 1 or a lower row to bypass the report header 
information if you choose.  

• Click Next 

 

• Scroll down past the header information and a cross to verify that the columns are 
correct. You can add, delete or move (change) a column as detailed in the Text 
Import Wizard – Step 2. 

• We suggest adding a column between ID and Date, between ID and Employee 
name, and between Employee Name and Key. 

• Click Next 
• Step 3 of the Text Import Wizard appears 
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Click Finish 

The data is now in Excel and you can manipulate it using any of the Excel functionality as 
needed. 
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Note the total of the GL Entries made. In this example it is $21.35. This represents Cash 
Advance Returns, Air Plus and Company Paid Payment Type items on the expense reports 
extracted from TTE/Concur. 

3. Open the Excel report you created in #1 

After you export the Detail Report-Extracted (sent for payment) into Excel you can add a 
couple of totals that will make reconciliation of transactions from TTE into TeamWorks 
relatively easy. 
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Sample of TTE data viewed in Excel with helpful totals added: 

 

• Add a total for the Expense Amount column (See A above) 
• Use the Excel SUMIF function to create totals for AirPlus (See B above), Company 

Paid (See C above) and Cash Advance Return (See D above) transactions in the 
Payment Type column (column K) in the report.  

o Sumif (Kx:Kxxx,”AirPlus”, Ux:Uxx 
o Sumif (Kx:Kxxx,”Company Paid”, Ux:Uxx 
o Sumif (Kx:Kxxx,”Cash Advance Return”, Ux:Uxx 

Note: xx= line numbers in Excel Report 

• Create a total for B,C,D  only (See E above) 
o This should be the same total that appears on the GLXXX0902 report from 

Document Direct (See F above) 
o I created a place to enter the Document Direct total (See E above) 
o Total E (See E above)and F  (See F above) should be the same 

• Create a total to net the GL totals (See E above) from the Expense Amount Column 
Total (See A above) 

o Subtract E (See E above) from A (See  A above) to create the total (See G 
above) 

o This total should equal the APXXX0855 total (See H above) 
o I created a place to enter the Document Direct total (See H above) 

• The GL Total (See F above) in the Detail Report – Extracted (sent for payment) and 
the total on the GLXXX and the AP totals 
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What Do I Do If My Balances Do Not Tie? 

Reporting imbalances between AP/GL report totals and the TTE Detail Report-Extracted 
(sent for payment) report is simple: 

• Identify the issue using the TTE Detail Report – Extracted (sent for payment) from 
TTE and the GLXXX0902 and APXXX0855 Reports from Document Direct. You must 
document the transactions that did not appear in the GLXXX0902 or APXXX0855 
report but were on the TTE Detailed Report-Extracted. 

• Contact SAO Customer Care via phone at 404-657-3956 (Option 9) or 888-896-7771 
(Option 9) or email to sao_travel@sao.ga.gov. 

• Have the TTE and Document Direct Reports and the detailed documentation of the 
issue ready to transmit to SAO immediately when requested or include with the 
email if issue emailed to SAO Travel. 

Once SAO TTE Support receives this detailed information, they will investigate and advise 
you of any corrective action necessary. 

 

Section 8: Important Information to Consider for 
Departing Employees  

Per the Statewide Travel Policy, travel expenses and advances must be reconciled within 
the TTE system as soon as possible, but no later than 45 calendar days after the completion 
of the trip or event. If your agency allows travel advances, any portion of an advance that 
was not used must be returned to the State, via check, within this same timeframe. 

For agencies using the TTE System, travelers must submit all expenses in the TTE system, 
“matching” the expenses to the approved advance. Refer to the State’s TTE System User 
Reference Guide for detailed procedures. To remain compliant with the Statewide Travel 
Policy regarding both expenses and travel advances TeamWorks Travel and Expense 
agencies have some important considerations to make before any full or part time employee 
leaves their agency.  

http://sao.georgia.gov/teamworks-travel-and-expense-training
http://sao.georgia.gov/teamworks-travel-and-expense-training
http://sao.georgia.gov/state-travel-policy
http://sao.georgia.gov/state-travel-policy
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In order to ensure accurate expense reconciliations, reimbursements of possible travel 
advances and to avoid unexpected budget impact, the TTE team recommends the following: 

 
• Encourage Managers and/or HR to notify the TTE administrator before the employee 

leaves, when possible. 
• Notify Managers and HR that TTE expense submissions must be made before the 

employee leaves or transfers out of your agency.  
• Consider adding this reminder to your agency exit checklist. 
• Run the following reports to identify outstanding expenses and unreconciled travel 

fees as well as cash advance balances (if applicable) which may be due. 
NOTE: Any impact here for the 196040? 

 
 196060 Unassigned Transactions - Detail of all AirPlus transactions not 

extracted into TeamWorks. 
 Unsubmitted Expense Reports - Detail of expense reports started but not 

submitted (no cash advances included). 
 Cash Advance Analysis  -  Identifies outstanding cash advance balances. 
 Unsubmitted Expense Reports with Cash Advances -   Detail of expense 

reports with cash advances attached but not submitted. 
 IRS Report – Identifies if employee has any taxable expense reports. 
 Unassigned CC & Itineraries - identifies This report contains two tabs: 

Unassigned Credit Cards_1 (credit card transactions not assigned to an 
expense report), and Unassigned Itineraries_2 (travel itineraries not assigned 
to an expense report) 

 

Section 9: Determining Potential Taxability of Employee 
Expenses   

Statewide Travel Policy Reference   

Pursuant to Section 7: Reimbursement for Travel Expenses of the policy currently in effect: 
 

7.1   General 

Employees are expected to exercise good stewardship of funds when traveling on 
official business.  Any expenditure disallowed by the State is the responsibility of the 
employee.  

7.2    Expense Reimbursement Timing 

Travelers should submit all expenses for reimbursement and reconciliation within 10 
days of the completion of the event or trip but no later than 45 calendar days. 
However, a reimbursement request will preferably be held (not entered into the TTE 
system) until an amount of at least $10 is due.   

IRS regulations state the traveler must adequately account to the employer and 
submit travel expense reimbursement requests within 60 days of the end of the trip. 
Such expenses, if reimbursed after 60 days, become taxable income to the traveler. 
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All expense reimbursement requests must be submitted as soon as possible, in 
conjunction with an employee’s last day of employment, when applicable, but no 
later than 45 calendar days after the last day of employment.  Outstanding requests 
not submitted after this time period will not subsequently be reimbursed.  The Office 
of Planning and Budget OPB Policy Memorandum No. 1 (Revision 5, May 2013) 
provides further guidance for recovering unrecovered Travel Advances, post-
employment.   

TTE IRS Report 

The Local Travel Administrator can determine expenses submitted in excess of 60 
days from the completion of the trip by running and evaluating the TTE IRS Report. 
This report should be run weekly. Also, consider running this report if someone is 
leaving the agency as well. 

Local Travel Administrators with reporting access to the TTE System should run the 
IRS Report weekly as follows: 

Log in to Concur and click on the Reporting tab 

 

Select the State Accounting Office Folder 

 

 

Scroll down to the IRS Report: 

 

 From the IRS (Number of Days to Submit Report) Prompt window: 

o Enter the date range to be reviewed 
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o Select the Business unit 
o Click Finish  

 

 

 

The report will display: 

 

 

To view this report in Excel, click the alternate view icon    , select View in Excel 
Options and then select the Excel format desired and then open the report. Where the 
report appears to open depends on the browser you are using. 
 

The report will export to Excel and you will have the full functionality of Excel to sort or 
manipulate the report data as needed. Sorting the data to include the # days to submit will 
bring potentially taxable instances to attention. 
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It is recommended that you evaluate the trip dates and submit dates. The employee may 
have made an error which resulted in a negative number or a HUGE number in the # days 
to submit field. Examples would be entering an incorrect year in the start or end dates or 
submitting the report before the end date of the expense report which would create a 
negative number. 

Once you determine that there are one or more taxable expense reports (60 days or greater 
listed in the days to submit field), provide a copy of the report to your HR/Payroll office as 
soon as possible.  The HR/Payroll office will handle the process from this point. 

HR/Payroll enters the total amount of the expense report on the employee’s payline in 
TeamWorks HCM, using earnings code TAI.  The information will be added to the employee’s 
payline during the normal “on-cycle” process. The “on-cycle” process depends on the pay 
cycle the agency is using – semi-monthly, weekly, or monthly.  

Section 10: General Year End Procedures  

Reports Agencies can run in TTE  

Agencies on TTE are encouraged to run and monitor any of the following reports below in 
Cognos Reporting to determine outstanding travel expense reports.  These reports should 
be reviewed prior to year-end close out to ensure all current year travel reports are 
processed in the current fiscal year. 

• Unsubmitted Expense Reports:    Detail of unsubmitted expense reports with 
amounts. 

• Unsubmitted Expense Reports with Cash Advances: Detail of unsubmitted 
expense reports with amounts and cash advances. 

• 196060 Pending Transactions:  Detail of AirPlus transactions (196060) NOT 
extracted to TeamWorks. 

• Cash Advance Analysis:   Shows the status of cash advance by employee. 

• IRS Report: Identifies any employees with taxable expense reports. 

Processing Travel Reports When Two Accounting Periods are open 

In order to facilitate year-end processing, the ‘trip end date’ in TeamWorks Travel & 
Expense (TTE) will be used to determine the accounting period in TeamWorks for travel 
expenses.  

All expense reports that are submitted 
between June 1st and July 10th , 2014 
(Dates will vary depending on the fiscal year) 

Should have a June or July ‘trip end date’ 
to determine the appropriate accounting 
period in TeamWorks.    
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Employees submitting reports with 
expenses prior to June 

Need to change the ‘trip end date’ to a 
June date on the report header, before the 
report can be submitted.   

From July 1-11 (Dates may vary for each 
fiscal year) 

Agencies will need to determine the 
appropriate accounting period and revise 
the ‘trip end date’ accordingly.   

NOTE: To ensure that expense reports are approved and extracted before TeamWorks year-end 
processing, no travel expense reports should be submitted by employees after July 10, 2014.  The 
date depends on the fiscal year. The dates shown are for Fiscal 2014. 

What Do Agencies Need to Do if Users Receive the Audit Rule Below? 

SAO has created an audit rule specifically for year-end processing.   The audit rule 
does not trigger until the traveler has “submitted” their expense report.  If an 
approver or back office processor receives an expense report with the following audit 
rule: 

“Expense reports submitted or extracted in July must have trip end date in June or 
July to determine the correct fiscal year.  Please modify the trip end date in report 
header and resubmit.” 

Please return the report to the employee so that the ‘trip end date’ can be changed to an 
open period (either June or July). 

Company Paid Reconciliation for Car Rental and Direct Bill Hotel 

Please review account 200006 (Company Paid Car Rental/Hotel) to ensure that the 
account has a zero balance at year-end.  If a balance exists, the agency should prepare 
a reconciliation between TeamWorks and Concur using existing queries in TeamWorks 
and reports in Cognos reporting.  

 Note: The Detail Report – Extracted (sent for payment date) and the Detail Report-
Not Extracted would be helpful here. 

Note: Effective 12/1/2015, Direct Bill Hotel will no longer clear through 200006 

Company Paid Reconciliation for Direct Bill Hotel (After 12/01/15) 

Effective 12/1/2015 account 200006 will no longer be used for Direct Billed Hotels. 
Please review account 196040 (Clearing Account – Hotel Direct Bill [Distributed]) and 
196041 (Clearing Account – Hotel Direct Bill [Undistributed]) to ensure that the accounts 
net a zero balance at year-end.  If a balance exists, the agency should prepare a 
reconciliation between TeamWorks and Concur using existing queries in TeamWorks and 
reports in Cognos reporting.  

 Note: The Detail Report – Extracted (sent for payment date) and the Detail Report-
Not Extracted would be helpful here. 
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General Procedures for Control/Clearing Accounts 
1. As stated in the Accounting Policy for Control/Clearing Accounts on the SAO website, 

“Travel clearing accounts may have balances in each individual account if, at the 
fund type level, the activity will offset over time by agency… At year-end, the 
balances are not required to net to zero by agency or fund type level.” 

 
2. For BCR/CAFR reporting, the SWAR group will reclassify the net balance for air travel 

and the net balance for hotel activity to the appropriate prepaid asset, 
expenditure/expense, or accrued liability, at the consolidated fund type level.  NOTE 
- If your agency prepares separate financial reports (e.g. CPA audited organizations), 
you will need to make these reclassifications in your financial statements. 

Tips for Reconciling Clearing Accounts 

To reconcile your clearing accounts, agencies can use the following: 

Existing queries in 
TeamWorks 

Queries can be used to review general ledger journals 
created from the extract from Concur to TeamWorks (196060 
account) and used to review payment activity to AirPlus 
(196061 account) 

TTE Reporting Used to run the report for unsubmitted expense reports 
(196060  Extracted Reconciliation, 196060 Pending 
Transactions, 196060 Unassigned Transactions) and Detail 
Reports – Extracted (sent for payment date) and Detail 
Report -Not Extracted 

TTE AirPlus payment detail 
reports 

Used to identify payment detail for payments made to AirPlus 
(196061 Air Plus Reconciliation) 

 

 

http://sao.georgia.gov/sites/sao.georgia.gov/files/imported/vgn/images/portal/cit_1210/11/62/185960074AM_COA_ControlClearingAccounts.pdf
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Reconciliation Webinar
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Concur Reconciliation
Airplus Reconciliation
Rental Cars/Hotels (Direct Bill)
TTE vs. PS Reconciliation
Departing Employees
Questions
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AGENDA



 Concur sends SAO 1 invoice for all TTE agencies
 Charges are based on submitted expense reports
Agencies get charged for “Deleted Expense 

Reports”
 SAO runs the “Billed Transaction Recon Detail” 

report in Concur to determine each agency’s 
portion

 SAO will code the invoice to the appropriate 
agency’s books, account 651010 class 312

 SAO will release payment to Concur
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Concur Reconciliation



 Airplus sends SAO 1 invoice for all TTE agencies
 Airplus invoice includes air and travel agency fees 

only
 SAO will reconcile the two clearing accounts 

(196060/196061) 
 Billing report details will be sent to agencies
 Most reconciling items will be AirPlus billed, but no 

traveler expense report submitted
 SAO will code the invoice to the appropriate 

agency’s books
 SAO will release payment to AirPlus
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Entry that is created when an employee submits an expense 
report
(Airfare and air tax – Out of State - $400)

DR – 40700.407011.6180101.10100.01000.01.640024 $400
CR – 40700.407011.6180101.10100.01000.01.196060 $400

(Travel Inc. Agency Fees - $4.27)
DR – 40700.407011.6180101.10100.01000.01.640004 $4.27

CR – 40700.407011.6180101.10100.01000.01.196060
$4.27

Entry that is created when SAO pays the Airplus bill
(Includes airfare and travel agency fee)

DR – 40700.407011.6180101.10100.01000.01.196061 $404.27
CR – 40700.CASH $404.27

Airplus Reconciliation 
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Entry that is created when an employee submits an expense 
report
(Hotel– Out of State - $250)

DR – 40700.407011.6180101.10100.01000.01.640003 $250
CR – 40700.407011.6180101.10100.01000.01.200006 $250

Entry that is created when the Agency pays the Hotel bill

DR – 40700.407011.6180101.10100.01000.01.  200006 $250
CR – 40700.CASH $250

Car/Hotel 
Reconciliation 
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 Encourage managers and/or HR department to notify the TTE 
administrator before an employee leaves

 Notify managers and/or HR that TTE expense submissions must be 
made before the employee leaves or transfers

 Establish internal process regarding departing employees and add this 
reminder to your agency exit checklist

 Agencies should be running the following reports every week to 
identify outstanding expenses, unreconciled travel fees, and travel 
advance balances which may be due:

 196060 Unassigned Transactions
 Unsubmitted Expense Reports
 Cash Advance Analysis
 Unsubmitted Expense Reports with Cash Advances
 IRS Report
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Departing Employees
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Attendees 

Section 1:  Permissions 

An agency administrator may or may not have the correct permissions to use this 
feature. The administrator may have limited permissions, for example, he/she can 
affect only certain groups and/or use only certain options (view but not create or 
edit).  

If an agency administrator needs to use this feature and does not have the proper 
permissions, he/she should contact the TTE Global Administrator at SAO.. 

Also, the administrator should be aware that some of the tasks described in this 
guide can be completed only by Concur. In this case, the client must initiate a 
service request with the TTE Help Desk at SAO..  

Section 2:  Overview 

For some expense types, such as business meals or entertainment, Expense users 
may be required – sometimes for corporate reasons; sometimes for legal reasons – 
to identify all attendees associated with that expense. In some cases, each individual 
attendee must be listed. In other cases, it may be acceptable for the user to simply 
enter a count (number of unnamed attendees). 

This guide describes how Expense users, approvers, delegates, and proxies use the 
Attendees feature. It also describes how the administrator configures the feature. 

• Attendee Features Available to All Expense Users 

In the basic attendee feature, an Expense user can add, edit, view, and remove 
attendees. 

• Optional (Configurable) Attendee Features 

There are many optional features that the Global Administrator can configure to 
enhance the user experience and to ensure that the agency is able to gather the 
desired (and required) attendee information. The configurable options are: 

• Some custom fields may be available specifically for attendees 

• Ability to track year-to-date attendee totals 

• Settings specific to each attendee type to: 

♦ Make all employees in an agency available within the attendee search 
function for selection and inclusion as an attendee 

♦ Have separate attendee forms for each attendee type  

♦ Allow attendee lists to be shared or private  
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♦ Allow users to enter new attendees into Expense 

♦ Set the available attendee types for an expense type by excluding 
attendee types and only displaying the remaining attendee types 

♦ Set a default attendee type for an expense type 

♦ Allow users to enter the count (number of unnamed attendees) instead of 
having to identify and enter each individually – for a defined attendee type 
(used in conjunction with the similarly named expense type/policy setting) 

♦ Have Expense check for duplicate records when users add new attendees 
to Expense 

♦ Define the search criteria available in the attendee section 

♦ Allow users to search and import attendees from an external source 

• Settings specific to each policy and expense type to: 

♦ Allow users to view the amount of the expense allotted to each attendee 

♦ Allow users to edit the amount of the expense allotted to each attendee 

♦ Allow users to account for attendees who were invited but did not attend 
("no shows") 

♦ Allow users to enter the count (number of attendees) instead of having to 
identify and enter each individually – for a defined expense type and 
policy (used in conjunction with the similarly named attendee type 
setting) 

♦ Include the Expense user as an attendee by default 

♦ Suppress the Add New Attendee button for an expense type 

• Features specific to Expense groups: 

♦ Attendee types available for this group to use 

♦ Configurable view of information in attendee lists (columns available for 
view) 

♦ Audit rules relating to attendee totals and frequency of attendance 

• Allow the administrator to import attendee lists from other applications 

• Allow users to import attendees (using an Excel worksheet) into a specific 
expense 

• Show users My Team tab (direct reports or users with the same approver) 
while searching for attendees. 

• Allow users to forward a calendar email (as .ics attachment) to Concur, which 
creates an entry with the meeting attendees that the user can use on their 
expense report. 



Page | 3         T e a m W o r k s  T r a v e l  &  E x p e n s e  S y s t e m         Version Date: 09/22/2015                         
              A t t e nd e e  A d m in i s t r a t i o n                  
 

Section 3:  What the User Sees - on the Expense Report Page 

NOTE: This section describes the tasks the user can complete using the expense 
report page. Many of the same tasks can be completed on the user's Profile 
page. The information about the Profile page is discussed in What the User 
Sees - in Profile in this guide. 

The Attendees section of the New Expense (or Expense) tab appears whenever 
an expense type requires attendees which is currently Group Meals.  

 

Using the Attendees section, a user can:  

• Add an existing attendee or attendee group to the expense  

• Search for an existing attendee or attendee group 

• Add any employee at their company, not just those in Favorites or previously-
used (configurable) 

• Edit or view attendee information  

• Create a new attendee (configurable)  

• Create an attendee group 

• Remove an attendee from an expense 

• Account for "no shows" (configurable) 

• Enter a count (number of unnamed attendees; configurable) 

• Import attendees (using an Excel worksheet) into an expense (configurable) 

• Search for and import attendees from an external source (configurable) 
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NOTE: The administrator can also restrict – by attendee type – the attendees that a 
user can create, edit, view, or search for, as described in the configuration 
portion in this guide. 

• Adding a Favorite Attendee or Attendee Group to an Expense 

There are two ways for a user to add an attendee or attendee group to an expense if 
the attendee or group is already in his/her favorites (as listed in Profile > Profile 
Settings > Favorite Attendees): 

• Use the Search Recently Used field 

• Use the Favorites button 

 

• Use the Search Recently Used Field  

Using the Search Recently Used field, a user can: 

• Add one or more individual attendees – one at a time – to the expense  

• Add one or more attendee groups – one at a time – to the expense 

 

To do so, in the Search Recently Used field, the user can type any of these: 

• One or more letters of an attendee's name 
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• One or more letters of an attendee's company name 

• One or more letters of a group name 

• An asterisk (to see the entire list) 

A list appears, with the attendee groups at the top of the list. The user selects the 
desired attendee or group. The selected attendee or attendee group is added to the 
expense. 

• Use the Favorites Button 

• Add One or More Individual Attendees 

In the Attendees section of the New Expense (or Expense) tab, the user clicks 
Favorites. The Favorites tab of the Search Attendees window appears. 

  

When accessed this way, the Favorites tab lists the user's favorite attendees (as 
listed in Profile > Profile Settings > Favorite Attendees) minus those already 
assigned to the expense. 
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The user selects one or more attendees and then clicks Add to Expense. The 
selected attendees are added to the expense. 

 

• Add One or More Attendee Groups 

In the Attendees section of the New Expense (or Expense) tab, the user clicks 
Favorites. The Favorites tab of the Search Attendees window appears. 

The user clicks the Attendee Groups tab. 
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The user selects one or more groups and then clicks Add to Expense. All members 
of the selected group(s) are added to the expense. 

 

 
• Copying Attendees from a Request (from Concur Request) 
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The user can copy attendees from a request associated with an expense report 
directly to that report's expense entry, provided the entry allows attendees.  

A user adds a request to an expense report: 

• On the Active Requests page, by clicking Expense in the Action column 

 

– or – 

• With the request open, by clicking the Create Expense Report button 

 

When Expense detects that the request entry has attendees, it makes them available 
to copy from that request directly to an expense entry. This behavior saves the user 
entry time, and allows the user to work with the attendees just as if they were 
available in Expense.    

To add the attendees from the request, the user creates an expense entry that 
includes attendees, such as Business Meals. When the Attendees window appears 
within the New Expense screen, Expense displays the Copy Attendees from 
Request (#) button.  
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By clicking this button, all attendees from the request are copied to the new expense 
entry. There, they can be removed, added to Favorites, or worked with just as if they 
had been added through Expense. 

• Adding Attendees from a Calendar Email 

The system can be configured to allow users and their delegates to import attendees 
from a calendar invitation email sent to Concur. A user can include the 
receipts@concur.com email as a meeting participant, or a user or delegate with a 
verified email address can forward an Outlook meeting invitation email (with .ics file) 
to receipts@concur.com. Concur will then create an expense with an attendee list 
based on the meeting participants, which appears in Available Expenses. The user 
can associate the expense to an expense report and enter additional information 
about the meeting, including adding more attendees if necessary.  

NOTE: If the list of participants visible in the meeting is showing a distribution list 
rather than named individuals, then Concur will only receive the distribution 
list as an attendee. The individuals in the list will not be created as attendees.  

This feature is enabled on the Settings tab of the Attendees page.  

 For more information, refer to the Step 5: Adding Additional Attendee Types 
and Working with Other Attendee Settings > Overview: Settings section of 
this guide.  

There are two methods the employee can use to bring the calendar invite attendees 
into Concur:  

• Including Concur as an attendee (Recommended) 

• Forwarding the calendar invite to Concur 

• Including Concur as an Attendee (recommended) 

The user creates the meeting in Outlook, including receipts@concur.com as an 
attendee. The original meeting invitation and any updates will be sent to Concur. If 
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the information is not yet added to an expense (is still available), then Concur will 
update the information each time a new email update is received. If the user adds 
receipts@concur.com as a participant at a later date, the user needs to send the 
update to all participants rather than just to those that have been added. 

 

• Forwarding the Calendar Invite to Concur 

The event organizer or a participant can also send the meeting (as an .ics file) to 
receipts@concur.com, from a verified email address.  

• Outlook on PC 

The user can open the meeting in Outlook, then click Forward > Forward as 
iCalendar. 

mailto:receipts@concur.com
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• Outlook on Mac 

The user can drag-and-drop the meeting from the Outlook calendar to the 
attachment field in a new email. Outlook will attach the .ics file to the email. The 
user can then send the email to receipts@concur.com. 
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• Delegate Functionality 

A user's delegate can send the calendar email to Concur on behalf of the user. The 
delegate and the user they are delegating for must both have verified email 
addresses in Concur. The delegate attaches the .ics file to the email using the 
methods described above, and includes the delegator's email address in the email's 
Subject: line.  

 

The delegate cannot enter multiple email addresses on the subject line. The delegate 
must send a single email for each calendar invitation they will add to the system for 
each employee they are assisting.  

• Adding the Calendar Expense to a Report 

Concur creates the meeting as an expense with the attendees listed, which appears 
in the Available Expenses section of the Expense page. The Subject: line of the 
email will appear in the Expense Detail column. If the email subject is blank, 
Concur will set the Expense Detail to Business Meals – Meetings.  

 

NOTE: While the calendar expense is in the Available Expenses list, Concur will 
update it if any updated emails about the meeting are received. Once the 
calendar expense is added to the report, Concur will no longer update it.  
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The user can add the expense to a report several ways:  

• The user can select the check box for the expense and click Move > To New 
Report to create a new report or Move > reportname to add the expense to 
an existing report. 

 
• The user can drag-and-drop the expense onto an existing report tile.  

• The user can drag-and-drop the expense onto the Create new report tile.  

Once the expense with attendees is added to a report, the user can add, remove, 
and edit the attendees as usual. 

• Important! 

This feature is not recommended for use by employees who must report attendee 
information based on managed lists of attendees, such as sales staff who fall under 
the US Healthcare Reform (Sunshine Act) for reporting prescriber recipient benefits 
to the government.  The feature can be enabled for the company as a whole, with 
procedural training for this specialized group to advise against using this option for 
reportable spend.  In the event this type of user forwards an email to Concur with 
regulated attendees, the attendees will not be matched to the company’s internal 
list, and will typically be created as regular business guests. This then requires 
proactive action by the user to delete the attendee and replace with a selection from 
the managed list. 

 

• Searching for an Attendee  
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When the user clicks Advanced Search, the Search Attendees tab of the Search 
Attendees window appears.  

 

The user clicks the appropriate attendee type, enters part of the name, etc., and 
clicks Search. The search results appear. 

The user selects the desired attendee(s) and clicks Add to Expense.  

• Searching by all Available Employees at a Company 

The system can be configured to search all employees at a company for selection 
and inclusion as an attendee (and simultaneous auto-creation of an attendee record 
for that employee). To configure this feature (if not already available at your site), 
refer to Making All Employees Available in an Attendee Search in the Configuration 
section of this document. 
 
NOTE: Users can search an external source for attendees and import them into 

Expense. Refer to the Fetch Attendee Web Service information on 
http://developer.concur.com. 

• Searching Employees on My Team 

The system can be configured to display the My Team tab on the Search 
Attendees window. This tab displays the group of employees that are related to the 
current user in the following ways:  

http://developer.concur.com/
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• The employees share the direct approver with the user.  

• The employees report directly to the user.  

Concur uses the configured approval hierarchy to determine the team structure. 
Delegates will see the My Team employees for the users that they are delegating for, 
not their own team.  

  

• Using Recently Used Attendees 

The user accesses the Recently Used tab by clicking Favorites or Advanced 
Search. The Search Attendees window appears. The user clicks the Recently 
Used tab.  



Page | 1 6         T e a m W o r k s  T r a v e l  &  E x p e n s e  S y s t e m         Version Date: 09/22/2015                         
              A t t e nd e e  A d m in i s t r a t i o n                  
 

 

The Recently Used tab lists the last 25 attendees that the user has used minus 
those already assigned to the expense. 

The user selects one or more attendees and then clicks Add to Expense.  
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• Editing or Viewing Attendee Details 

A user can edit attendee information only if the user originally added the attendee to 
Expense. Otherwise, the user can view – but not edit – attendee information.  

In the Attendees 
section, the user 
selects the desired 
attendee, then 
clicks Edit. The 
Edit Attendee 
Details window 
appears.  

When done, the 
user clicks Save. 

The following 
information may display (read-only) on this page (not shown in the sample above):  

• Audit rule exception message: If an audit rule exception has been 
generated for this attendee 

• Totals (including, but not limited to):  

♦ Total amount YTD (total spend on this attendee by the entire company 
year-to-date)  

♦ Total Amount Previous Year (total spend on this attendee by the entire 
company last year)  

♦ Employee Amount YTD (total spend on this attendee by the current user 
year-to-date)  

♦ Employee Amount Previous Year (total spend on this attendee by the 
current user last year)  

Note the following: 

♦ This total per attendee will begin to aggregate at the point the option is 
configured; it will not retroactively include expenses submitted prior to its 
activation. However, for those importing managed lists of attendees, a 
starting year-to-date total may be imported when creating a new attendee 
record. 

 For more information about importing attendees, refer to Import a 
List of Attendees in the configuration section in this guide. 

♦ Whether any or all these totals are visible to users is configurable, as 
described in configuration portion of this guide.  

♦ The attendee types that are visible to users (by groups) is configurable, as 
described in configuration portion of this guide. 

 Viewing and editing attendee information can also be completed by the user 
in Profile. Refer to What the User Sees - in Profile in this guide. 



Page | 1 8         T e a m W o r k s  T r a v e l  &  E x p e n s e  S y s t e m         Version Date: 09/22/2015                         
              A t t e nd e e  A d m in i s t r a t i o n                  
 

• Editing or Viewing Amounts 

• Viewing Amounts  

Whether users can edit – or even view – the amounts allotted to attendees is 
configurable, as described in the configuration portion of this guide. 

Attendees section without individual totals visible: 

 

Attendees section with read-only totals: 

 

Attendees section with editable totals: 

 

TIP: If you add a number of additional fields to this display, move the Attendee 
Count column to the left for easier viewing on laptop or netbook devices - use the 
Form Fields tab (in Forms and Fields) to do this. 

• Changing Amounts 
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When attendees are added to an expense, the system automatically distributes the 
amount of the expense evenly across attendees.  

 

If the configuration allows the user to edit amounts, the user can click in the 
Amount column and change the value, if necessary. 

 

When the user clicks out of the Amount column, Expense redistributes the 
remaining portion of the expense evenly between the remaining attendees. 

 

• Understanding How Expense Distributes and Redistributes 
Amounts 

Keep the following in mind about changing amounts:  

• Expense initially distributes the amount of the expense equally across 
attendees. That is, if the expense amount is 100 USD and there are two 
attendees, Expense allots 50 to each attendee.  

• If a user adds or removes an attendee, Expense redistributes the amounts. In 
the above example, if the user removes one attendee, then the remaining 
attendee is allotted the full 100. If the user adds another attendee (so now 
there are two again), Expense redistributes again, allotting 50 to each.  
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• If the user manually changes an amount, Expense will not later change that 
amount while redistributing.  

♦ Assume that the user edited the amount of attendee A to be 30 and the 
user let Expense automatically adjust attendee B's amount to be 70. If the 
user now adds attendee C, Expense will redistribute 70 across attendee B 
and C; Expense will not change attendee A, which remains at 30.  

♦ Assume that the user edited the amount of attendee A to be 30 and 
manually changed attendee B's amount to be 70. If the user now adds 
attendee C, Expense allots zero to attendee C. The user must manually 
adjust amounts to account for attendee C; Expense will not automatically 
change the amount for attendee A or B.  

• Amounts cannot be edited for expenses marked as personal or the "parent" 
portion of an itemized expense.  

 For information about how Expense handles amounts and copydown, refer to 
Copy Down Itemization Information to Attendees in this guide. 

• Creating a New Attendee  

The user can create an attendee using the New Attendee button. The Edit 
Attendee Details window appears. 

The user selects the desired type from the Attendee Type list. The page refreshes 
with the appropriate fields for the selected attendee type. 

The user completes the remaining fields and clicks either Save or Save & Add 
Another. 

Expense then checks for duplicate attendees. If it finds one or more potential 
duplicates, the user is prompted to use the existing attendee information (if the 
attendee that the user is adding and the duplicate are, in fact, the same person) or 
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to continue adding the attendee (if the attendee that the user is adding and the 
duplicate are not the same person).  

The new attendee is added to the expense and is added to the user's favorites list. 

Note the following: 

• The user can change the Attendee Type value for an attendee added to a 
report or request up to the point at which the report or request is submitted, 
after which this value is locked down by the system. 

• Whether users can add new attendees is configurable, as described in the 
configuration portion of this guide. 

• The attendee duplicate type check by default is limited to attendees of the 
same type, however it can be expanded to all attendee types on the Settings 
tab of the Attendees page in Expense Admin. 

• The company can also decide whether to implement "carry-forward." It is 
similar to copydown but it copies data from one attendee to another (for 
example, company name) when the user is adding attendees, as described in 
the configuration portion of this guide. 

• By default, the New Attendee button appears to the user. The administrator 
can suppress this button in the Attendees section to prevent a user from 
adding an attendee – forcing the user to search for the attendee first, 
ensuring the attendee is not already in the system. 

 

NOTE: This change affects only the Attendees section of the New Expense 
(or Expense) tab – not the other attendee "grids" (like Profile 
favorites) that contain a New Attendee button.  

• Removing an Attendee from an Expense 

The user selects the check box of the desired attendee, then clicks Remove. The 
attendee is removed from the expense.  
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Removing the attendee from the expense does not remove the attendee from the 
user's favorites list. Amounts are redistributed, as described in Understanding How 
Expense Distributes and Redistributes Amounts in this guide. 

• Creating an Attendee Group 

A user can create an attendee group using an existing expense from an expense 
report, either unsubmitted or submitted. To do so, the user selects the desired 
attendees and clicks Create Group. 

 

In the Create Group 
window, the user enters a 
group name and clicks Save.  

NOTE: The group names do 
not have to be unique. 

 Creating an attendee group can also be completed by the user in Profile. 
Refer to What the User Sees - in Profile in this guide. 

• Accounting for "No Shows" 

A user can account for No Show attendees. For example, assume that an event was 
planned for three attendees, prepaid in the amount of 300 USD, which means each 
of the attendees would be allotted an amount of 100. Now assume that one of the 
attendees cancelled at the last minute so only two attendees were present. By 
default, each attendee would be allotted an amount of 150. By using the No Show 
feature, the user can indicate that one attendee was a no show so that other 
attendees reflect the correct amount of 100 each. 

Totals when not accounting for "no shows": 
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Totals when accounting for "no shows": 

 

The remaining 100 is not allotted to the absent attendee and does not affect the 
absent attendee's annual totals. 

The No Show feature is not available for expenses marked as personal or the 
"parent" portion of an itemized expense. 

NOTE: Whether users can use the No Show feature is configurable, as described in 
configuration portion of this guide.  

• Entering a Count for Unnamed Attendees 

In some cases, it is acceptable for the user to enter a count – number of unnamed 
attendees – instead of listing each attendee individually. For example, assume that 
the user purchased a gift for a doctor and the "group" gift for the employees in the 
doctor's office. 

 

NOTE: Whether users can enter "counts" instead of entering all attendees 
individually is defined by expense type/policy and attendee type, as described 
in the configuration portion of this guide. 

• Copy Down Itemization Information to Attendees 
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Assume that a user itemizes an expense that has attendees and your system is 
configured to copy down the attendees to the itemizations. If so, attendees entered 
at the parent expense can copy down to any itemization with attendees. On the 
initial creation of the itemizations, the attendees present on the parent expense will 
copy to the itemization. If the user then makes changes to the attendees on the 
parent expense (for example, add an additional attendee), the user will be asked if 
he/she wants to copy the change to the itemizations. 

In this example, there are two attendees, each allotted half ($30) of the itemization 
($60). 

 

When the user adds a third attendee to the parent expense, the user is prompted 
about carrying the change to the itemizations. 
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Upon clicking Yes, the third attendee is added to the itemization and the amounts 
are adjusted. 

 

• Important! 

Be aware that - when Expense added the third attendee to the itemization, it added 
up the individual attendee amounts (from the two attendees) and then divided by 3. 
If the user had made manual adjustments to the amounts, the user must adjust 
them again. Because of the way Expense handles amounts, its only option is to 
divide the amounts equally.  

NOTE: Whether amounts are copied down is configurable, as described in 
configuration portion of this guide.  

• Additional Attendee Information - Attendee Summary 

• Expense List 
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The user can view attendee information on the expense report page – without using 
the New Expense (or Expense) tab. The user hovers the mouse pointer over the 
attendee  icon in the expense list to see the attendees associated with the 
expense. The user can see the attendee counts and totals by attendee type by 
hovering the mouse pointer over the attendee  icon in the Attendee Summary 
window.  

 

• New Expense (or Expense) Tab 

The user can view the attendee count and totals by attendee type using the New 
Expense (or Expense) tab. To do so, the user hovers the mouse pointer over the 
attendee  icon in the Attendees section.  

 

• Additional Attendee Information - Attendee Detail View 

• Change Columns 

There are several places in Expense where attendee information is presented in 
tables, such as the Attendees section of the New Expense or Expense tab (as 
shown in the figure below). 
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By default, the information that the user sees in these tables includes the attendee 
name, type, company, and title. The administrator can customize this information. 
The administrator can add any of the following: 

• First Name 

• Last Name 

• Middle Initial 

• Suffix 

• Custom 1-20 

• Attendee Entry Custom 1-5  

• Total Amount Previous Year 

• Total Amount YTD 

• Attendee Count  

• Status (used primarily with the Fringe Benefit Tax feature in Australia and 
New Zealand) 

 Refer to the Expense: Fringe Benefits Tax (FBT) Setup Guide for more 
information. 

Once the new "view" configuration is created, it is implemented by assigning it to 
one or more Expense groups. 

• Example - Add a Field 
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For example, by default, the Attendees section of the New Expense (or Expense) 
tab contains the Attendee Name, Attendee Title, Company, and Attendee Type 
columns. (Visibility of the Amount column is configurable.) 

 

Assume that a company is in the pharmaceutical industry where it is important for 
the user to know the state in which the attendee (doctor) practices. Further assume 
that the administrator added a custom field (renamed State) to the attendee form. 
Using the Attendee Detail View feature, the administrator can also easily add that 
same field to this display. 

 

• Affected Pages 

This change affects the most common attendee grids, so when the administrator 
adds or removes a column, the change appears in these places: 

• Attendees section of the New Expense (or Expense) tab (shown above)  

• Search Attendees window:  

♦ Accessed by clicking Search in the Attendees section of the New 
Expense (or Expense) tab 

♦ Includes all four tabs: Search Attendees, Favorites, Recently Used, 
and Attendee Groups 
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• Expense list attendee summary tool tip:  

♦ Accessed by hovering the attendee  icon in the expense list 
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• Favorite attendees in profile:  

♦ Accessed by clicking (current UI) Profile > Favorite Attendees or  
(enhanced UI) Profile > Profile Settings > Favorite Attendees. 

♦ Includes both tabs: Attendees and Attendee Groups 

 

 Refer to Configuring the Attendee Detail View in this guide. 

• Using the Personal Attendee Import Feature 

Expense users can import attendees into an expense. This feature benefits users who 
must list a large number of attendees, for example, for seminars or department 
functions. A limit of 5,000 records in a single import is enforced, after which 
additional records are ignored (i.e., record 5,001 and on). 

When Expense is configured to use the attendee import feature, the Import button 
appears in the Attendees section. 
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The user clicks the Import button. The Attendee Import window appears.  

 

Using this window, the user accesses an Excel worksheet (formatted with the 
attendee fields) and saves it to his/her computer or network.  

The user opens the worksheet in Excel, enters the attendee records (up to and not 
over 5,000 per import), and saves. 

The user then imports the competed worksheet into Expense. Once imported, 
Expense displays the attendee information. The user reviews the information for 
accuracy. 
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Then: 

• If the information is correct, the user clicks Next. 

• If the information is not correct (and the user notices the error), the user 
clicks Cancel, corrects the worksheet, and imports again. 

In the next step, Expense checks for errors, for example, missing "required" 
information. Any attendees that appear on this page will not be imported. 

 

Then: 

• If the user wants the attendee to be imported, the user clicks Done (which 
cancels the process), corrects the worksheet, and imports again. 

• If the user does not want the attendee to be imported (perhaps the user has 
decided to add the attendee later - manually, without using the import), the 
user clicks Next. 

In the next step, Expense checks for possible duplicates by comparing the attendees 
on the worksheet to attendees already in the system and displays the possible 
duplicates in a split window. The possible duplicate from the worksheet appear in the 
top portion of the window. When the user selects a row in the top window, that 
person's possible duplicate (an existing attendee) appears in the bottom part of the 
window. 

Then: 

• If a possible duplicate (from the worksheet) truly is an existing attendee, the 
user selects the attendee in the bottom part of the window and clicks Use 
Selected Attendees.  

• If the possible duplicate (from the worksheet) is not an existing attendee, the 
user clicks Continue Adding New Attendee.  

Note the following: 

♦ Duplicate records still count against the overall import limit of 5,000 
attendee records for a single import 

♦ Attendees that are missing required fields can be imported. The attendees 
must have at least the Last Name and Attendee Type field completed. The 
user can add all other required fields to the attendee record after import.  
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♦ Attendees that are in your Favorites are not treated as duplicates, 
providing that the attendee record appears once, and only once, in your 
favorite attendees. 

♦ When the system checks for possible duplicates, it is first looking for an 
exact match on the External ID. The External ID is unique to each 
attendee. It is generally the attendee ID obtained from the client's HR or 
CRM system and is not likely to be included in the worksheet. It then 
looks for duplicates based on the fields configured for duplicate check for 
that attendee type. 

 For more information about the External ID, refer to External ID - 
Required for Imported Changes and Deletions in the configuration 
section in this guide.  

♦ If Expense finds more than one possible duplicate (so that several names 
are listed at the top and bottom of the page), the user deals with each 
one individually. 

♦ Attendees of type SYSEMP (Employee), where the user is not allowed to 
create a new attendee record, can now be imported and will be matched 
to one existing employee record.  

♦ Attendee types where the user may not create a new attendee record but 
may search for attendees from a company-managed list may be included 
in the import file. The system will attempt to find a match with existing 
attendees in the system, and will fail the record if no match is found. 

♦ The attendee duplicate type check by default is limited to attendees of the 
same type, however it can be expanded to all attendee types on the 
Settings tab of the Attendees page in Expense Admin. 

When done, the user clicks Next. The final page appears. 
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On this page, note the following definitions: 

• Skip: A skip occurs if an attendee is added to an expense and then the user 
imports the same worksheet with the same attendee to the same expense. 

• Failed: The system detected that at least one required field was missing and 
the user elected to not import that attendee. 

• Duplicate: As described previously, the system compares information from 
the attendees on the worksheet to the attendees already in the system. If the 
External IDs are not an exact match, the user is asked to indicate if the 
imported attendee truly is a duplicate.  

 For more information about the External ID, refer to External ID - 
Required for Imported Changes and Deletions in the configuration 
section in this guide. 

When the user clicks Done, the attendees are imported into the expense. 

Section 4:  What the User Sees - in Profile 

• Attendees Tab 

The Attendees tab in the user's profile lists the attendees that appear in the user's 
favorites list in the Attendees section of the New Expense (or Expense) tab. 
Using this page, the user can manage his/her favorites list. 

 

Note the following: 

• This list is not necessarily all of the user's available attendees; it includes only 
the user's favorites. 

• The attendee types that are visible to users (by groups) are configurable, as 
described in configuration portion of this guide. 
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The user can use this tab to:  

• Create a new attendee  

• Edit or view attendee information  

• Delete / Hide an attendee  

• Find an attendee  

Note the following about the information that appears on this page: 
 

Information Description 

User Name 
(attendee 
type of This 
Employee) 

The user's name appears automatically in this list (depending on the 
configuration).  

Annual Total On this page, the attendee's name, title, company, and attendee type 
always appears. The Annual Total column may appear, based on the 
company's configuration. If so: 
• The amount shown is the total amount spent company-wide in the 

current calendar year for that attendee (not only from the current 
user) 
– and –  

• The currency used is:  
♦ The currency that is set in the import record, if the attendee was 

imported 
– or –  

♦ The same as the user's reimbursement currency, if the attendee 
was added by a user  

NOTE: There are two ways to add the total column to the Attendees tab 
(both described in the configuration section of this guide).  
• One involves the attendee Settings page; that setting adds the 

Annual Total column to the Attendees tab. 
• The other option involves using the Attendee Detail View form. 

Adding the Attendee Total YTD field to the view will provide the 
same result but will also add this information to several other places, 
like the Attendees section of the New Expense (or Expense tab), 
the Search Attendees page, etc.  

 Refer to Additional Attendee Information - Attendee Detail View 
in this guide. 

Audit Icon A red audit icon appears if an audit rule exception has been generated for 
that attendee. 

• Creating a New Attendee 
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To add a new attendee to the user's attendee favorites list, the user clicks New 
Attendee, completes the Add Attendee page, and then clicks Save or Save & Add 
Another. 

 

NOTE: The company can also decide whether to implement "carry-forward." It is 
similar to copydown but it copies data from one attendee to another (for 
example, company name) when the user is adding attendees, as described in 
the configuration portion of this guide. 

• Editing Attendee Information 

A user can edit attendee information only if the user originally added the attendee to 
Expense. To do so, on the Attendees tab, the user clicks either: 

• The attendee's name (link)  
– or – 

• The check box to the left of the attendee's name and clicks Edit 

The user edits the desired information and clicks Save.  

• Deleting / Hiding Attendees 

When using this feature, the attendee is actually deleted from Expense only: 

• If the user originally added the attendee to Expense 
- and -  

• If the attendee has not been associated with an expense  

In all other cases, the attendee information is simply removed (hidden) from the 
user's attendee favorites list and can be located using the using the Advanced 
Search link.  

To delete, the user selects the check box associated with the attendee and clicks 
Delete.  
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NOTE: The attendee can also be deleted from the Favorites tab of the Attendees 
section of the New Expense (or Expense tab).   

• Finding Attendees 

The user can search his/her favorites list using the Find every attendee where 
area. The user completes the fields and clicks Go. The search results appear. 

NOTE: Be aware that this "find" option is searching the attendees in the favorites list. 
To locate attendees that the user has deleted (removed), the user clicks 
Advanced Search.  

• Attendee Groups Tab  

Using Profile, users can manage their groups of favorite attendees. Users can: 

• Create, edit, and delete groups 

• Send a copy of one or more groups to another Expense user 

• Create a Group of Favorite Attendees 

Note the following: 

• Attendees that a user adds to a group must first be in the user's favorites list.  

• Each group can have as many as 500 individual members. 

• A user can create an unlimited number of groups. 

• An attendee can belong to more than one group. 

To create a group, the user clicks Profile > Favorite Attendees (left menu) and 
then selects the Attendee Groups tab. The user clicks Add New.  

 

The user's list of favorite attendees appears. 

The user selects each attendee to be included in the group and types a name for the 
group in the Group Name field. 

NOTE: The name does not have to be unique but it is a best practice to have unique 
group names. 
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The user clicks Save Group. The selected attendees now appear in a group. 

 

• Edit a Group 

The user uses the edit feature to: 

• Add more attendees to an existing group  
- or -  

• Remove attendees from an existing group 

On the Attendee Groups tab, the user selects the group and clicks Edit. 

 

The user makes the desired changes and clicks Save Group. 

• Delete a Group 
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When a user deletes a group, the group is dissolved; the individual attendees are still 
available in the user's favorites list. If a user deletes an attendee from the favorites 
list and that attendee is in one or more groups, a confirmation message appears. 

To delete, on the Attendee Groups tab, the user selects one or more groups and 
clicks Delete. 

• Send a Copy of a Group to Another User 

A user can send a copy of one or more groups to another user. The group then 
appears immediately on the recipient's Attendee Groups tab; all individual 
attendees in the group also appear on the recipient's Attendees and Favorites 
tabs.  

To send a copy to another user, on the Attendee Groups tab, the user selects one 
or more groups and clicks Send Copy. 

 

In the Send a copy of the selected group(s) window, the user finds the desired 
recipient and clicks Send. 

 

NOTE: The selected group(s) can be sent to only one recipient at a time. 

Note the following: 

• Remember - this is a copy. Any modifications that the original owner makes 
to the group will not affect the recipient; any modifications that the recipient 
makes to his/her copy will not affect the original owner's group. 
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• Since the group names do not have to be unique, the copy cannot overwrite 
or otherwise destroy data in the recipient's group list. 

• If the recipient does not have access to an attendee type, any attendees of 
that type will not be included in their copy of the group. 

• Attendee Detail View 

You can add additional information to the attendee grids (tables) in Profile as 
described in Additional Attendee Information - Attendee Detail View in this guide. 

Section 5:  Delegates, Proxies, Approvers, and Processors 

• Delegates and Proxies 

All of the features described here for Expense users are also available to delegates 
and proxies. 

• Attendee Types Restricted by Groups 

If the administrator has defined attendee types by groups, when a delegate or proxy 
accesses attendee information on behalf of a report owner, the attendee types 
available are based on the types defined for the report owner's group. 

• Approvers and Processors 

! IMPORTANT! Before reading this section, review Understanding How Expense 
Distributes and Redistributes Amounts in this guide to understand the 
relationship between manual changes to amounts and Expense's automatic 
redistribution of amounts among attendees. 

Like most forms and fields, the attendee forms and fields can be configured so that it 
is either read-only or editable (modify) for the approver and/or processor. If so, 
modify means:  

• The approver and/or processor can add attendees to and remove attendees 
from an expense.  

• Neither the approver nor the processor can manually adjust the amount of 
the expense allotted to each attendee. However, if the approver or the 
processor lower the total amount of the expense, then the individual 
attendee-allotted amounts are adjusted proportionally. 

• If the approver and/or processor add or remove an attendee and: 

♦ If the user has not manually changed any amounts, then Expense will 
automatically redistribute the amounts equally among all attendees. 

♦ If the user manually changed some but not all amounts, then Expense will 
redistribute the amounts over the attendees whose amounts the user did 
not change as well as any new attendees added by the approver or 
processor.  
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♦ If the user manually changed all amounts, then Expense cannot 
redistribute the amounts. On save, an exception is created because the 
amounts no longer balance. Though the approver/processor is encouraged 
to return the report to the employee for editing, the report can be 
approved/processed.   

• Attendee Types Restricted by Groups 

If the administrator has defined attendee types by groups, when an approver or 
processor accesses attendee information on behalf of a report owner, the attendee 
types available are based on the types defined for the report owner's group. 

Section 6:  Configuration – Overview and Procedures 

This portion of the process requires the role of Expense Configuration Administrator.  

• Different Processes for Different Options 

Clients wanting to take advantage of the extended attendee functionality may opt-in 
to the following features. The optional features are applied in these ways: 

• Global: Applies to all expenses that require attendees 

• By attendee type: Set based on the attendee type 

• By expense type within the policy: Set based on the expense type and 
policy, using the Expense Types page 

• By Expense Group: Configured and then applied to one or more Expense 
groups 

The attendee features are listed in the table below and are described in detail on 
the following pages. 
 

Configured by Feature  Global Attendee 
Type 

Expense 
Types Group 

20 custom fields available specifically for 
attendees X    

Ability to track year-to-date attendee totals X    

Separate attendee forms for each attendee 
type  X   

Allow attendee lists to be shared or private  X   

Allow or prevent users to enter new 
attendees into Expense  X   

Have Expense check for duplicates when 
users add new attendees to Expense  X   

Duplicate checks are performed across all 
attendee types X    
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Configured by Feature  Global Attendee 
Type 

Expense 
Types Group 

Define the search criteria that appear on 
the attendee helper  X   

View the amount of an expense allotted to 
each attendee   X  

Edit the amount of an expense allotted to 
each attendee   X  

Account for attendees who were invited but 
did not attend ("no shows")   X  

Include the Expense user as an attendee by 
default   X  

Suppress the Add New Attendee button 
by expense type   X  

Set a default attendee type for an expense 
type    X  

Allow only some attendee types to be 
chosen for an expense type by excluding all 
others 

  X  

Allow users to enter the count (number of 
unnamed attendees)  X X  

Import of attendee lists by administrator 
from other applications X    

Import of attendee lists by users X    

Allow the automatic creation of an attendee 
record for the current employee (SYSEMP 
attendee type) 

X    

Create audit rules relating to attendee 
totals and frequency of attendance    X 

Auto-generate the External ID, used if 
importing lists of attendees 

X    

Restrict attendee types by user group    X 

Configure the Attendee Detail View (form)    X 

Search for and import attendees from 
external source 
NOTE: This option requires the Fetch 
Attendee web service. Refer to the Fetch 
Attendee Web Service information on 
http://developer.concur.com. 

 X   

• The Basic Configuration Process 
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These steps are described briefly here and described in detail on the following 
pages: 

Step 1: Define the attendee forms and fields. 

Step 2: Edit the Attendees field on the Expense Entry form (optional). 

Step 3: Configure the Attendee Detail View (optional). 

Step 4: Edit the attendee-related expense types. 

Step 5: Add additional attendee types and select attendee settings. 

Step 6: Include all employees in a company in the attendee search. 

Step 7: Create the desired attendee audit rules (optional). 

Step 8: Configure the Excel worksheet to be used for personal attendee 
imports (optional). 

Step 9: Import a list of attendees (optional). 

• Step 1: Defining the Attendee Forms and Fields 

• Overview: Attendee Forms and Fields 

In this step, you configure one or more forms used for attendees. You can create as 
many attendee forms as necessary, for example, one for each attendee type if 
desired, or for example by company type, by using the Health Care Professional 
(HCP) attendee form. 

• General Notes about Attendee Forms 
• Expense provides a default attendee form. To create new forms, make a copy 

of the default form and then edit the copy. 

• Expense also provides company-specific forms, such as the Health Care 
Professional (HCP) attendee form. 

• An administrator can create as many attendee forms are needed. 

• Attendee forms are administered at (current UI) Administration > Expense 
Admin > Forms and Fields or (enhanced UI) Administration > Expense 
> Forms and Fields. 

♦ Once the Expense Attendee form type is selected, the list of forms is 
displayed. The forms can be expanded to display the currently configured 
fields.  

♦ Use the Attendee Detail View form type to provide additional information 
in the most common attendee grids (tables) as described in Additional 
Attendee Information - Attendee Detail View in this guide. 

 Refer to the Expense: Forms and Fields Setup Guide for general 
information about forms and fields. 
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• General Notes about Attendee Fields 
• For the most part, attendee fields are like all other fields except attendee 

fields cannot be configured as connected lists. 

• Refer to the Approvers and Processors section in this guide for information 
about using the "modify" field attribute for approvers and processors. 

• The attendee fields are listed below.  

The attendee fields are: 
Field Name Description 

Attendee Count Total count of attendees by this attendee type 

Attendee Name Attendee's name 

Attendee Title Attendee's work title 

Attendee Type Business Guest, Spouse, and so on 

Company Attendee's company 

Company Category 1 
Authorized Amount 
Previous YTD 

Total pre-authorized spend on this attendee on selected 
expense categories by the entire company last year 

Company Category 1 
Authorized Amount YTD 

Total pre-authorized spend on this attendee on selected 
expense categories by the entire company year-to-date 

Company Category 1 
Submitted Amount 
Previous YTD 

Total spend on this attendee on selected expense categories 
by the entire company last year 

Company Category 1 
Submitted Amount YTD 

Total spend on this attendee on selected expense categories 
by the entire company year-to-date 

Company Category 2 
Authorized Amount 
Previous YTD 

Total pre-authorized spend on this attendee on selected 
expense categories by the entire company last year 

Company Category 2 
Authorized Amount YTD 

Total pre-authorized spend on this attendee on selected 
expense categories by the entire company year-to-date 

Company Category 2 
Submitted Amount 
Previous YTD 

Total spend on this attendee on selected expense categories 
by the entire company last year 

Company Category 2 
Submitted Amount YTD 

Total spend on this attendee on selected expense categories 
by the entire company year-to-date 

Created By (Private List) Defines the "owner" of the attendee information 

 For more information, refer to Private vs Shared Attendee 
Lists on the following pages. 

Currency Key As defined in the import, if imported; or same as the user's 
reimbursement currency, if the attendee was added by a user  

Custom 1-20 Custom fields as defined by the company  
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Field Name Description 

Attendee Entry  
Custom 1-5 

Custom fields used to collect information specific to the 
attendee on the current expense; this data can be extracted 
using the Attendee Detail extract 

Employee Amount 
Previous Year 

Total spend on this attendee by the current user last year 

 For more information, refer to Amount Fields (Edit 
Attendee and Details) on the following pages. 

Employee Amount YTD Total spend on this attendee by the current user year-to-date 

 For more information, refer to Amount Fields (Edit 
Attendee Details) on the following pages. 

Employee Category 1 
Authorized Amount 
Previous YTD 

Total pre-authorized spend on this attendee on selected 
expense categories by the current user last year 

Employee Category 1 
Authorized Amount YTD 

Total pre-authorized spend on this attendee on selected 
expense categories by the current user year-to-date 

Employee Category 1 
Submitted Amount 
Previous YTD 

Total spend on this attendee on selected expense categories 
by the current user last year 

Employee Category 1 
Submitted Amount YTD 

Total spend on this attendee on selected expense categories 
by the current user year-to-date 

Employee Category 2 
Authorized Amount 
Previous YTD 

Total pre-authorized spend on this attendee on selected 
expense categories by the current user last year 

Employee Category 2 
Authorized Amount YTD 

Total pre-authorized spend on this attendee on selected 
expense categories by the current user last year 

Employee Category 2 
Submitted Amount 
Previous YTD 

Total spend on this attendee on selected expense categories 
by the current user last year 

Employee Category 2 
Submitted Amount YTD 

Total spend on this attendee on selected expense categories 
by the current user year-to-date 

External ID Required for imported attendee records 

 For more information about the External ID, refer to 
External ID - Required for Imported Changes and Deletions in 
the configuration section in this guide. 

First Name Attendee's first name 

Last Name Attendee's last name 

Total Amount Previous 
Year 

Total spend on this attendee by all users company-wide last 
year 

 For more information, refer to Amount Fields (Edit 
Attendee Details) on the following pages. 
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Field Name Description 

Total Amount YTD Total spend on this attendee by all users company-wide year-
to-date 

 For more information, refer to Amount Fields (Edit 
Attendee Details) on the following pages. 

Status Used primarily with the Fringe Benefit Tax feature in Australia 
and New Zealand 

 Refer to the Expense: Fringe Benefits Tax (FBT) Setup 
Guide for more information. 

• Private vs. Shared Attendee Lists 

If an attendee list is private, then: 

• Only the current user can use attendees from this list 

• Only the current user can search this list  

• If the user is allowed to add attendees to the list, then Expense will search 
only this user's attendees for duplicates 

If an attendee list is shared, then: 

• Any user can use attendees from this list 

• Any user can search this list  

• If users are allowed to add attendees to the list, then Expense will search all 
users' attendees for duplicates 

The Created By (Private List) field, which is not visible to the user, has two 
functions. It is used by Expense: 

• To identify the "owner" of the attendee for editing or deleting; for example, in 
order for a user to edit attendee information or delete an attendee, the user 
must be the owner 

• To identify if an attendee list is private or shared 

Whether or not you include this field as one of the search fields and the duplicate 
search fields ultimately defines whether attendees list are private or shared. 

Further explanation: Remember, the Created By (Private List) field is always 
hidden and is always populated with the user's user ID (cannot be changed; cannot 
be deleted). So, if you add the Created By (Private List) field to the search fields 
or the duplicate search fields, the field is always part of the search or duplicate 
search.  

• In the case of the search fields, the system will find only those attendees who 
have that same user ID in the Created By (Private List) field. In other 
words, the system will not search outside of the user's attendees. So, to keep 
a list private, add the Created By (Private List) field – users will not find 
each other's attendees.  

• In the case of duplicate search fields, the system will match only attendees 
who have that same user ID in the Created By (Private List) field. In other 
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words, the system will not search outside of the user's attendees for 
duplicates. 

Summary: What do you want to accomplish? 
 

Searching for Attendees  

Type of List Description Configuration 

Shared I want each user's 
attendee list to be shared 
for this attendee type.  
That is, I want users to be 
able to search for 
attendees with this type 
created by anyone in the 
company or imported from 
a master list by the 
company. 

When defining forms, on the Forms tab: 
1. Select the form type of Expense 

Attendee. 
2. Select the desired form. 
3. Click Modify Form. 
4. In the Modify Form window, ensure 

that Created By (Private List) field is 
not checked. 

 Refer to Configuring Attendee Forms and 
Fields in this guide. 

Private I want each user's 
attendee list to be private.  
That is, I want users to be 
able to search for 
attendees with this 
attendee type only in their 
own attendee list. 

When defining forms, on the Forms tab: 
1. Select the form type of Expense 

Attendee. 
2. Select the desired form. 
3. Click Modify Form. 
4. In the Modify Form window, ensure 

that Created By (Private List) field is 
checked. 

 Refer to Configuring Attendee Forms and 
Fields in this guide. 

 
Searching for Duplicates  

Type of List Description Configuration 

Shared When a user adds an 
attendee with this 
attendee type, I want 
Concur to search for 
duplicates among all 
attendees with this type 
created by anyone in the 
company or imported 
from a master list by the 
company. 

Click Administration > Expense > 
Attendees, on the Attendee Types tab: 
5. Select the attendee type. 
6. Click Modify. 
7. In the Attendee Type window, in the 

Fields for duplicate search list, do 
not select Created By (Private List).  

 Refer to Adding Additional Attendee 
Types and Working with Other Attendee 
Settings in this guide. 
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Private When a user adds an 
attendee, I want Concur 
to check for duplicates 
only among attendees 
with this type in the 
user's attendee list. 

Click Administration > Expense > 
Attendees, on the Attendee Types tab: 
8. Select the attendee type. 
9. Click Modify. 
10. In the Attendee Type window, in the 

Fields for duplicate search list, select 
Created By (Private List). 

 Refer to Adding Additional Attendee 
Types and Working with Other Attendee 
Settings in this guide. 

Additional optional setting for duplicate attendee searches 

Shared or 
Private 

The two options above 
restrict the search to the 
same attendee type.  
I want to search all 
attendee types for 
duplicates. 

11. Configure Shared or Private as described 
above. 

12. Click Administration > Expense > 
Attendees. 

13. On the Settings tab, select (enable) the 
Check for attendee duplicates across 
attendee types check box. 

 Refer to Adding Additional Attendee 
Types and Working with Other Attendee 
Settings in this guide. 

• Amount Fields (Edit Attendee Details) 

The amount fields that appear on the Fields tab provide the accumulated totals (in 
profile and in the Edit 
Attendee Details window in 
Expense) if you add these fields 
to the desired attendee form. 

This example shows the 
Employee Amount YTD and 
Total Amount YTD fields 
added to the attendee form for 
the Business Guest attendee 
type.  

• Procedure: Configuring Attendee Forms and Fields 

• Access Forms and Fields 

  To access the attendee forms and fields: 

1. In the current UI, click Administration > Expense Admin > Forms and 
Fields (left menu) 
- or -  
In the enhanced UI, click Administration > Expense > Forms and Fields. 

2. In the Form Type list, click Expense Attendee. 

• Use the Forms Tab - General 
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 To make general changes on the Forms tab: 

1. To view the fields on the form, click the  to the left of the form name. 

 

2. To create another form, click an existing form and click Copy Form. 

3. To add additional fields to the form: 

♦ Click the form. 

♦ Click Add Fields. 

♦ Select the desired fields. 

♦ Click Add Fields. 
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• Use the Forms Tab - Search Fields 

 To Define the Search Fields: 

4. To define the search fields (the fields that appear on the Search Attendees 
window), on the Forms tab, click the form. 

5. Click Modify Form. 

6. Select the desired fields. 

7. Click Save. 
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• Use the Form Fields Tab - General 

 To make general changes on the Form Fields tab: 

8. To change the characteristics of a field: 

♦ Either: 

• Double-click the desired field. 
– or  

• Click the desired field and click Modify Form Fields. 
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♦ Make the desired changes. 

♦ Click Save. 

9. To remove a field: 

♦ Select the field. 

♦ Click Remove Form Fields. 

10. To change the sequence of the fields, drag-and-drop a field to the new 
location. 

• Use the Form Fields Tab - Configure Carry-Forward 

When a user manually enters attendee information (name, company, job title, etc.) 
and the attendees are (for example) from the same company, the user must repeat 
the company name for each attendee. However, you can configure the system so the 
attendee information is automatically copied (carried forward) from one manual 
entry to the next.  

First, the company decides which attendee fields, if any, use the carry-forward 
feature. 
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Typically, a company would have attendee type, company, and any custom fields 
carry forward.  

This feature works when the user adds attendees in Profile > Favorite Attendees 
or from the expense. However, the information is carried forward only when the 
user clicks Save & Add Another; it does not carry-forward on Save. 

 To configure carry-forward: 

The feature is implemented like copy-down.  

11. Either: 

♦ Double-click the desired field. 
– or  

♦ Click the desired field and click Modify Form Fields. 

12. In the Default Value Type field, click Copy Down. 

 

13. In the Copy Down Source field, click Expense Attendee. 

14. In the Field field, click the name of the source field (which would be the same 
name as the field you are currently editing). 

15. Click Save. 

• Step 2: Editing Expense Entry Forms for Copydown  

• Overview: Copydown 

Attendees (and amounts) entered at the parent expense can copy down to any 
itemization with attendees. 

 For information about how the feature works, refer to Copy Down Itemization 
Information to Attendees in this guide. 

The configuration process is: 

• Edit the Attendees form field on the affected Expense Entry form(s) 

• Ensure the itemization form is correct for the affected expense type(s) 

• Procedure: Modify the Attendees Field 

NOTE: If your configuration has several Expense Entry forms that contain the 
Attendees field, then all must be modified. In this case, we have only one - 
Entertainment. 
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 To modify the Attendees field: 

16. In the current UI, click Administration > Expense Admin > Forms and 
Fields. 
- or - 
In the enhanced UI, click Administration > Expense > Forms and Fields. 

17. In the Form Type list, click Expense Entry. 

18. Click the Form Fields tab. 

19. Click the Entertainment form to expand it. 

20. Either: 

♦ Double-click the Attendees field. 
– or –  

♦ Click the Attendees field and click Modify Form Fields. 

The Modify Form Fields window appears. 

 

21. In the Itemization Field Source, click Parent Expense. 

22. Click Save. 

• Procedure: Verify the Itemization Form for the Expense Type 

Ensure that the expense types use the proper form for itemizations. For example, in 
this case, the Business Meal expense type use the Entertainment form (which 
includes attendees) for the parent expense but uses the Default form (no attendees) 
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for the itemizations. In order for the attendees to copy down, the Entertainment 
form must be used for the itemizations. 

 To verify or change: 

23. In the current UI, click Administration > Expense Admin > Expense 
Types.  
- or -  
In the enhanced UI, click Administration > Expense > Expense Types. 

 

24. Click the expense type (in this case, Business Meals). 

25. Click Modify. 

26. Make no changes on the General tab; click Next. 

27. On the Policies tab, select the appropriate form in the For an Itemized 
Entry use this form column (in this case, Entertainment). 

 

28. Click Next to navigate through the remaining pages. 

29. Click Done. 

• Step 3: Configuring the Attendee Detail View 

• Overview: Attendee Detail View 
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Use these steps to provide additional information or suppress display of elements in 
the most common attendee grids (tables) as described in Additional Attendee 
Information - Attendee Detail View in this guide. 

The configuration steps are: 

• Configure the view (form) 

• Assign the form to one or more Expense groups 

• Procedure: Configure the View 

In the examples below we will add as custom field (Custom 01 renamed State) to 
the view. 

 To configure the view to add a new field: 

30. In the current UI, click Administration > Expense Admin > Forms and 
Fields.  
- or -  
In the enhanced UI, click Administration > Expense > Forms and Fields. 

31. From the Form Type list, click Attendee Detail View. 

 

! IMPORTANT: This view will be assigned to one or more groups. 
Unless the changes will be assigned to all groups, consider making a 
copy of the form so you still have the original with the original 
configuration. 
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32. Then, on the Forms tab (for the desired form or copy), click Add Fields. 

 

33. Select the desired field and click Add Fields. The new field is added. 

 

Note the following: 

• Like any other form, you can use the Forms Fields tab to modify field 
properties, change the sequence, and remove fields. 

• The Fields, Connected Lists, and Validations tabs are not available since 
they do not apply to "view" forms.  

 To assign to an Expense group: 

34. In the current UI, click Administration > Expense Admin > Group 
Configurations (left menu).  

In this case, assume that 
custom 01 has already 
been renamed to "State." 
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- or - 
In the enhanced UI, click Administration > Expense > Group 
Configurations. 
The Group Configurations page appears. 

35. Click the desired group and click Modify. 

 

36. In the Attendee List Form field, select the desired view form. 

 

37. Click Save. 

• Step 4: Editing the Attendee-Related Expense Types 

• Overview: Understanding Attendee Count Configuration 
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When allowing user-entered attendee count, two settings (expense type/policy and 
attendee type) are used together. 

• The expense type/policy setting indicates whether the user can enter a count 
for this particular expense type, for example, Business Meals. 

 
• The attendee type setting indicates whether the user can enter a count for 

this particular attendee type, for example, Business Guest. 

 

If at least one attendee type is configured to be editable, then at least one expense 
type must be configured to be editable (and vice versa). If not, the column never 
displays (and, hence, the count is never editable). 

Assume in this example: 

• The Business Meals expense type is configured to be editable. 

• The Business Guest attendee type is configured to be editable. 
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For each Business Meal expense type, the Attendee Count column appears and: 

• The field is editable for each Business Guest attendee.  

• For any other attendee type, the field is not editable. 

For each expense type that is configured for attendees and is other than Business 
Meal, the Attendee Count column does not appear, regardless of attendee type. 

• Moving the Attendee Count Column for Visibility 

The Attendee Count column that displays in the Attendee Detail Form view can be 
moved to a different location within the grid, for example, leftwards for greater 
visibility to laptop and netbook users. To move the field, the Expense admin first 
opens the Attendee Detail View form in Forms and Fields, then, using standard drag 
and drop technique, moves the field to its new location (in the figure below, to the 
second position from the leftmost): 

 

• Procedure: Editing Expense Types 

 To edit an attendee-related expense type: 

38. In the current UI, click Administration > Expense Admin > Expense 
Types (left menu). 
- or - 
In the enhanced UI, click Administration > Expense > Expense Types. 
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39. Either: 

♦ Double-click the desired expense type. 
– or – 

♦ Click the desired expense type and click Modify. 

 

40. Click Next enough times to access the Attendees tab. 

 

41. Select or clear the desired check boxes, as described below. 
 

Field Description 

Show Cost per 
Attendee 

Select this check box to allow users to view the amount of 
the expense allotted to each attendee.  
If selected, the Amount column appears in the 
Attendees section of the New Expense (or Expense) 
tab.  

Allow users to edit 
the Cost per Attendee 

Select this check box to allow users to edit the amounts in 
the Amount column. 

Allow users to enter 
the count of "No 
Shows" 

Select this check box to allow users to account for no 
shows – attendees who were invited but did not attend. 
If selected, the No Shows field appears in the Attendees 
section of the New Expense (or Expense) tab. 

Allow users to edit 
the count of 
attendees 

Select this check box to allow users to enter a count 
(number of unnamed attendees) for this expense type. 
If selected, the Attendee Count column appears in the 
Attendee section of the New Expense (or Expense) tab. 
NOTE: Remember, this feature is used in conjunction with 
attendee type settings. Refer to Procedure: Configuring 
Attendee Types in this guide. 
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Field Description 

Include user as an 
attendee by default 

If this check box is selected, Expense automatically adds 
the user as an attendee when the user accesses the 
attendees section the first time (when no attendees are 
assigned to the entry). 
Once attendees are assigned or if the user removes 
himself/herself as an attendee, Expense does not attempt 
to add the user again. 

42. Click Next and then Done. 

43. Use these same steps to edit all desired expense types. 

• Overview: Restricting Attendee Types by Expense Type 

To reduce the possibility of selecting the wrong attendee when working with expense 
types the administrator can filter the available attendee types. This is done by 
suppressing the display of selected attendee types under the Exclude Attendee 
Types column when modifying expense types within a policy. 

NOTE: If the form assigned to an expense type does not include the Attendees 
field, the feature cannot be used because the Exclude Attendee Types 
column (explained below) will not appear. 

The attendees available for selection are filtered at the following points in Expense: 

• New Attendee 

• Attendee Search 

• Attendee Groups 

• Favorite Attendees 

• Attendee Import for Expense Type 

• Does NOT impact Attendee functionality in the My Profile page 

• Exclusion of Attendees - Special Cases 

• Attendee Groups: At the Attendee Group level, if all attendees are of a type 
excluded for the combined Policy and Expense Type, then none will be 
available for selection.  

• User Attendee Import: In the Excel-based User Import, these excluded 
attendees will import successfully, but each will be flagged and manual 
removal is required to ensure successful report submission.  

• Procedure: Filtering Attendee Types for Expense Types by 
Exclusion 
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 To exclude attendee types for selected expense types: 

44. In the current UI, click Administration > Expense Admin > Policies. 
- or -  
In the enhanced UI, click Administration > Expense > Policies. 

45. Click a policy, then click Expense Types. 

46. Configure the expense type to exclude attendees by navigating to the 
Exclude Attendee Types and noting the status: 

♦ Add: Appears when no attendees have been excluded. 

♦ Modify (#): Appears when <#> number of attendees are excluded. 
 

 

47. Click either Add or Modify <#>, the Exclude Attendee Types window 
appears (figure below shows 1 attendee type (Spouse) excluded from 
Entertainment-Other). 

 

48. Under the Exclude column, either: 

♦ Exclude the attendee type: Select (enable) the associated check box. 
– or – 

♦ Include the attendee type: Clear (disable) the associated check box. 

49. Optional: Repeat for each expense type you will exclude attendee types for. 

50. Click Save. 

NOTE: If the option is not available, the Attendee field will need to be added 
to the form for the given expense type. 
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• Overview: Setting a Default Attendee Type for an Expense Type 

A single attendee type can be specified as the default attendee type for an expense 
type when selecting and working with an expense in a report.  

• Procedure: Setting the Default Attendee Type for an Expense 
Type 

 To set the default attendee type for an expense type: 

51. In the current UI, click Administration > Expense Admin > Policies. 
- or - 
In the enhanced UI, click Administration > Expense > Policies. 

52. Click a policy, then click Expense Types. 

53. Either: 

♦ Double-click the desired expense type. 
– or – 

♦ Select the desired expense type and click Modify Properties. 

The Modify Expense Type Properties window appears. 

 

54. Select a single attendee type from the drop down list. 

NOTE: The list of available attendees may be limited if some attendee types 
have been excluded for the expense type. 

55. Click Save. 
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• Overview: Suppressing the New Attendee Button by Expense 
Type 

By default, the New Attendee button appears to the user. The administrator can 
suppress this button in the Attendees section to prevent a user from adding an 
attendee – forcing the user to search for the attendee first, ensuring the attendee is 
not already in the system. 

 

• Procedure: Suppressing the New Attendee Button by Expense 
Type 

In this example we will use Policies to suppress the Add Attendee button by the 
Airfare expense type. 

 To configure the view to suppress the Add Attendee button: 

56. In the current UI, click Administration > Expense Admin > Policies. 
- or - 
In the enhanced UI, click Administration > Expense > Policies. 

57. Select the policy, then click Expense Types. 

 

58. Click the expense type (Airfare, in this example) and click Modify Properties 
to open the Modify Expense Type Properties dialog box. 
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59. Clear the Display the New Attendee button from the attendee table 
(shown in its selected, default state in the figure below). 

 

60. Click Save. 

• Step 5: Adding Additional Attendee Types and Working with 
Other Attendee Settings 

There are two pages: Attendee Types and Settings 

• Overview: Attendee Types  

On the Attendee Types page, you can: 

• While adding or editing attendee types: 

♦ Define the fields that are used in "duplicate" searches 

♦ Define whether to allow users to add attendees of this type 

♦ Define whether to allow users to enter an attendee count of this type 

♦ Define the data source to search for that attendee type  

• Inactivate attendee types 

• "This Employee" Attendee Type 

Expense uses this attendee type when it automatically adds Expense users as 
attendees. This is a system attendee type, so it cannot be inactivated.  

NOTE: The automatic creation feature can be turned off, however, it is recommended 
that it remains on. Refer to the information about the attendee Settings tab. 
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On the Edit Attendee Type page: 
Field Description 

Attendee Type This Employee 

Attendee Type Code SYSEMP; cannot be edited 

Expense Attendee Form Default Attendee Form 

Fields for duplicate search External ID and Created By (Private List) 

Allow users to add attendees of this type No; cannot be edited 

Allow users to edit the count for this type No; cannot be edited 

• Procedure: Configuring Attendee Types  

 To access the attendee types: 

In the current UI, click Administration > Expense Admin > Attendees (left 
menu). 
- or -  
In the enhanced UI, click Administration > Expense > Attendees. 
The Attendees page appears. 

 

 To modify an attendee type: 

61. On the Attendee Types tab, either: 

♦ Double-click the desired attendee type. 
– or – 

♦ Select the desired attendee type and click Modify. 

The Attendee Type window appears. 
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62. Complete the appropriate fields. 
Field Description 

Attendee Type Name Change the name as desired. 

Attendee Type Code Change the code as desired. The code can be 1 to 8 
alphanumeric characters, all uppercase, no spaces. 

Expense Attendee Form Select the desired attendee form. 

Fields for duplicate search Select the field(s) that will be used to check for 
duplicates. 
NOTES:  
• If the intent is for your users to have private 

attendee lists, then include the Created By 
(Private List) field as a duplicate search field for 
this attendee type.  

• If you plan to have the system check for 
duplicates across attendee types, note that the 
system will successfully check for duplicates 
across attendee types only if the duplicate check 
fields are the same on all attendee types. 

Data Source for Attendee 
Search 

Select the data source used when searching for 
attendees of this type. 
NOTE: This field is used by the Fetch Attendee 
Callout. If you are using this callout, select the 
system that you configured in the Register 
Application Connectors page of Web Services 
Admin.  

 Refer to the Fetch Attendee Callout information 
on http://developer.concur.com. 
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Field Description 

Allow users to add 
attendees of this type 

Select this check box to allow users to add attendees 
with this attendee type. 
NOTE: If you are using the Fetch Attendee Callout, 
this check box will be cleared and not editable. 

Allow users to edit the 
count for this type 

Select to allow users to enter a count (number of 
unnamed attendees) for this attendee type.  
IMPORTANT: This option is used in conjunction with 
the expense type setting. Refer to Overview: 
Understanding Attendee Count Configuration in this 
guide. 

63. Click Save. 

 To add a new attendee type: 

64. On the Attendee Types tab, click New. The Attendee Type window 
appears. 

 

65. Complete the fields as described in the previous section about editing existing 
attendee types. 

66. Click Save. 

 To deactivate an attendee type: 

Note the following about deactivating an attendee type: 

• When you deactivate an attendee type, all attendees with that attendee type 
are also marked as inactive and are no longer available for users to include on 
an expense. 
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• An attendee type that has been deactivated cannot later be made active. 

• If you deactivate an attendee type and then later want to use it again, create 
a new attendee type. You cannot use the same name as the original. You can, 
however, modify the original and rename it. Then, you can create the new 
attendee type using the original name of the deactivated attendee type. 

67. On the Attendee Types tab, select the desired attendee type(s). 

68. Click Deactivate.  

 

• Overview: Settings  

On the Settings tab, you can: 

• Define the expense types that will be included when calculating attendee 
totals 

• Define whether the Annual Total column displays in Profile 

 
• Define whether attendee types are restricted by user groups 

• Define whether duplicate attendee searches happen across attendee types 
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• Define whether to allow Expense to automatically create an attendee record 
(SYSEMP attendee type) for the current user 

• Define whether to have the system generate an External ID for attendees 
manually added by users 

 For more information about the External ID, refer to External ID - 
Required for Imported Changes and Deletions in this guide. 

• Define whether the user sees the My Team tab on the Attendee Search 
window. 

• Define whether the user can forward calendar emails to Concur to create an 
expense entry with the calendar meeting attendees. 

• Annual Total Column 

If you choose to display the Annual Total column in Profile, be aware that: 

• The amount shown is the total amount spent company-wide for that attendee 
(not only from the current user) for the selected expense type(s) 
– and – 

• The currency used is: 

♦ The currency that is set in the import record, if the attendee was imported 
– or –  

♦ The same as the user's reimbursement currency, if the attendee was 
added by a user 

 There is another way to add this column to this page. Refer to Additional 
Attendee Information - Attendee Detail View in this guide. 

• Exchange Rates Required 

In order for the system to maintain totals for attendees, currency conversion may be 
required. The amount allotted to each attendee is calculated in the user's 
reimbursement currency. If the attendee currency is different from the user's 
reimbursement currency, then the system must convert the amount (in the user's 
reimbursement currency) to the amount in the attendee currency. In order for that 
conversion to be successful, the appropriate exchange rates must be imported.    

• If the Exchange Rates feature is activated and the user's reimbursement 
currency is included in the Exchange Rates import – converted to the 
attendee currency – then conversion takes place and the attendee totals are 
adjusted accordingly. 

• If the Exchange Rates feature is not activated or if the appropriate currency 
has not been imported, then the user sees a message that briefly explains the 
issue and refers the user to your company's Expense administrator. 

 For more information, refer to the Expense: Currency Admin Setup Guide. 

• Procedure: Configuring Settings 
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 To change settings: 

69. On the Attendees page, click the Settings tab.  

 

70. Complete the appropriate fields. 
Field Description 

Expense Types to be 
included in the annual 
total of cost per attendee 

Select the expense types that will be included when 
calculating annual totals for attendees. 
NOTE: If you do not select any expense types, the 
annual total will not be calculated. 
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Field Description 

Display My Team in 
advanced search options 

Select to display the My Team tab to the users when 
searching for attendees. The My Team tab contains 
the following employees: 
• Employees with the same direct approver. 
• Employees that are direct reports of the user. 

 Refer to Searching Employees on My Team in 
this guide. 
NOTES:  
• This feature may be confusing to users if your 

default Expense approver assignments are not 
aligned with your team structure.   

• This feature requires two additional attendee 
settings: 
♦ Allow automatic creation of employees as 

attendees (SYSEMP attendee type) must be 
enabled. Refer to below in this table for more 
details. 

♦ Employee attendees are a shared list under 
the SYSEMP attendee type. For more 
information, refer to the Procedure: Part 4 – 
Configure SYSEMP Attendee Type section of 
this guide.  

Allow users to add 
attendees from meetings 
via email to Concur (*.ics 
files) 

When enabled, the users will see a new section called 
Calendar Events in the Smart Expenses area. Any 
calendar emails the user sends to Concur will create a 
new item in the Calendar Events area that includes 
the calendar email attendees. The user can import 
into this item into their expense report.  

 Refer to Adding Attendees from a Calendar Email 
in this guide. 
NOTE: This feature is not recommended for use by 
employees who must report attendee information 
based on managed lists of attendees, such as sales 
staff who fall under the US Healthcare Reform 
(Sunshine Act) for reporting prescriber recipient 
benefits to the government.  The feature can be 
enabled for the company as a whole, with procedural 
training for this specialized group to advise against 
using this option for reportable spend.  In the event 
this type of user forwards an email to Concur with 
regulated attendees, the attendees will not be 
matched to the company’s internal list, and will 
typically be created as regular business guests. This 
then requires proactive action by the user to delete 
the attendee and replace with a selection from the 
managed list. 

Display attendee total for 
calendar year 

Select if desired. 
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Field Description 

Enable attendee type 
group management 

Select to define the attendee types available to 
different user groups. 

 Refer to Attendee Types by User Groups in this 
guide. 

Check for attendee 
duplicates across attendee 
types 

Select to expand the attendee duplicate check to all 
attendee types. Clear to keep the duplicate check 
limited to attendees of the same type. 
NOTE: The system will successfully check for 
duplicates across attendee types only if the duplicate 
check fields are the same on all attendee types. 

Allow automatic creation 
of employees as attendees 
(SYSEMP attendee type) 

ON by default; change if desired. 
NOTE: The system will automatically generate a 
record for each Expense user but only once the user 
takes one of these actions: 
• The user opens a new expense form where the 

user is required to be added by default. 
• The user completes a 'This employee' attendee 

type search from the Attendee section of the 
New Expense (or Expense) tab or from profile. 

• The user completes a quick search or a favorite 
search from the Attendee section of the New 
Expense (or Expense) tab. 

At the same time the user is added to the attendee 
list, the External ID field is populated with the user's 
Employee ID.  

 Refer to Including All Employees in a Company in 
the Attendee Search in this guide. 

Generate an External ID 
when a new attendee is 
created by a user 

Select to have the system create an external ID. 

 For more information about the External ID, 
refer to External ID - Required for Imported Changes 
and Deletions in the configuration section in this 
guide. 

Audit Rule Group By Field 
for Expense Reports 

Select the custom field that will be used when 
totaling the attendee information for audit rules. If no 
field is selected, all expenses will be used. 
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Field Description 

Category Group 1 for 
Attendee Totals 
Category Group 2 for 
Attendee Totals 

Select the expense categories that will be included 
when calculating annual totals for attendees.  
You may create two different expense category 
groupings. Once these are created, you can add the 
total fields to the Attendee Details window.  

 Refer to the Configuring Attendee Forms and 
Fields section of this guide for more information on 
defining the attendee fields.  
NOTE: Once the categories are configured, you will 
be unable to change them on this page. Contact 
Concur Client Support to make any changes. If you 
make changes to this page after attendee information 
has been saved, the attendee totals will not update 
with the new categories. Any new attendees created 
after the change will use the new categories for 
annual totals. 

71. Click Save. 

• Overview: Attendee Types by User Groups 

The administrator can define (or restrict) attendee types to specific groups. So, when 
a user adds, edits, views, or searches for an attendee, only the specified attendee 
types for that user's group will be available. For example, perhaps users in a Sales 
group can select and manage client attendees where non-Sales users cannot.  

This way, different groups of employees can see a restricted - and more appropriate 
- set of attendee types. 

NOTE: One case may occur rarely - If an attendee is added to an entry and if that 
specific attendee type is later made inactive for the user's group and if the 
user later opens the entry, that attendee's information will no longer be 
editable by the user. 

• Procedure: Configuring Attendee Types by User Groups 

The configuration includes two parts:  

• Attendee setting: One-time process to turn on the feature  

• Group configuration: Completed for each group 



Page | 7 6         T e a m W o r k s  T r a v e l  &  E x p e n s e  S y s t e m         Version Date: 09/22/2015                         
              A t t e nd e e  A d m in i s t r a t i o n                  
 

 To set the Attendee Setting option: 

72. On the Settings tab, select (enable) the Enable attendee type group 
management check box. 

 

73. Click Save. Now a new column - Attendee Types - appears on the Group 
Configurations page. 

 

 To assign attendee types to groups: 

74. On the Group Configurations page, click the Modify link in the Attendee 
Types column for the group you want to affect. The Configuration for 
group window appears. 
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All attendee types appear except No Shows and This Employee, since they are 
system attendee types and cannot be inactive. 

75. Select the check box for all attendee types that should be active for the 
group. 

Note the following - not all types can be activated/inactivated: 

♦ If an attendee type is set to Active at the parent group level, it will remain 
active at the child group level and cannot be changed to Inactive.  

♦ If the attendee type is set to Inactive at the parent group level, it can be 
overridden at the child group level and set to Active. 

76. Click Save. 

• Step 6: Including All Employees in a Company in the Attendee 
Search 

You can make every employee at your company available within an attendee search 
for ease of selection and addition to the report. When the employee is added, an 
attendee record is automatically created if no record already exists.  

• Procedure: Part 1 – Confirm Auto-Create Attendee Record is 
Enabled 

In this step you will verify that the setting to auto-create Attendee records is 
enabled.  

! Before proceeding with changes after initial implementation, ensure that, if the 
settings is not selected, why this is the case at your site. It is critical to 
understand why the setting is not enabled before altering the setting (it is 
selected by default) - there may be a strategic or system reason for inactivating 
it and that must be understood before proceeding. 

 To verify and  enable the Attendee Settings "Allow automatic..." setting: 

77. Click the Settings tab in Attendees.  
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78. Select the Allow automatic creation of employees as attendees 
(SYSEMP attendee type) check box. 

 

• Procedure: Part 2 – Attendee Types and Employee Attendee 
Records 

In this step, the existing attendee type Employee is renamed and saved to a more 
descriptive naming convention for your users. 

 To rename and save the Employee attendee type: 

79. On the Attendee Types tab, click Employee and click Modify. The Attendee 
Type window appears. 

 

80. Rename this attendee type, as each attendee type name must be unique - 
suggested changes based on Concur users: 

♦ All Employees are Concur Users 
Rename as "Employees (inactive attendee type)" to clearly show the user 
that, on selection of this attendee type, they are now searching across all 
employees using an inactive attendee type (see Step 3, next). 

♦ Some Users are Concur Users, But You Want to Search Everyone 
Rename as "Employees (not using Concur)" - this name instructs the user 
they are selecting employees "outside" of Concur users who are not yet 
associated with Concur (by way of attendee records in Expense). 

81. In the Fields for duplicate search list, ensure that Created By (Private List) 
is not selected. 
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82. Click Save. 

• Procedure: Part 3a – Inactivate the Employee Attendee Type if All 
Concur Users 

If you know that all employees you want in an attendee search are also Concur 
users, then best practice is to inactivate the "Employees (not using Concur)" 
attendee type renamed in Step 2 so that it is no longer available for selection by the 
user. 

If you are making this change after you have been collecting production data for a 
period, consider inactivating this attendee type and creating a new one. Doing this 
performs a user-wide "fresh start" for their employee attendee records by 
inactivating all existing Employee attendee type records. 

 To deactivate the Employee attendee type: 

83. On the Attendee Types tab, click Employees (not using Concur) and click 
Deactivate. 

 

84. Click Yes in the confirmation dialog box that appears. 

 

NOTE: It is important to note that inactivating any attendee type will inactivate all 
attendees of that type. This will remove these records from every user's 
Favorites and Favorite Groups, so prior notice of this change is suggested to 
explain the new behavior to your users.  

• Benefits of Inactivating - Standardizing Employee Records 

The benefit of inactivating all of the existing and many-times duplicated Employee-
Attendee records is to standardize your employees each to a single record. This 
allows you "cleaner" Reporting data, and precision of use for employees in any 
attendee role. The disadvantage is that your users will need to rebuild their favorite 
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employees list over time as mentioned above, and re-add employee records into 
their existing attendee groups. 

• Procedure: Part 3b – Add a New Attendee Type 

In this step, you will add a new attendee type using the identical name of the 
attendee type you deactivated in Step 3a.   

NOTE: Since the attendee type name and code must both be unique in the list, you 
are prevented from creating another with the same values. For the purposes 
of this exercise, you will simply edit an existing record to change its name 
(only) and thus make the old name once again available for use.  
 
For example, if you changed the Employee attendee type to "Employees (not 
using Concur)" and then deactivated it in Step 3a, you may now rename this 
deactivated attendee type to "Employees (no longer used)", save that 
change, and create a new attendee type using the name "Employees (not 
using Concur)" which is active and may be immediately put into use. 

 To add a new attendee type: 

85. On the Attendee Types tab, click New. 

86. Enter "Employees (not using Concur)" as the new attendee type name, and a 
different attendee type code, such as EMPLOYES, not to exceed the limit of 7 
characters. 

87. Select the additional fields to meet your company's needs (as described 
earlier in this guide) - they make look similar to the figure below: 

 

88. Click Save.  
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• Procedure: Part 4 – Configure SYSEMP Attendee Type 

In this step, the SYSEMP attendee type is configured for attendee search. 

 To configure the SYSEMP attendee type for attendee search: 

89. Under Attendees > Attendee Types tab, select SYSEMP under Attendee 
Type Code. 

90. Click Modify, and rename the attendee type to Employees or similar name 
that best represents those employees who are users of Concur. 

91. Under Expense Attendee Form, select Default Employee Attendee Form to 
make this a shared list. 

Discussion: This can utilize any attendee form that you have created for this 
purpose that is configured as a shared list (that is, Created By is not selected 
in the form search attributes under Modify Form). If you have not created a 
special Attendee form for Employees, the Default Employee Attendee Form 
will correctly set the configuration to allow this to be a shared list for attendee 
searches. 

92. Under Fields for duplicate search, adjust Fields for duplicate search for use 
with a shared list by selecting and clearing duplicate search field selections: 

♦ Remove (clear the check box): Created By (Private List) 

♦ Add (select the check box): First Name, Last Name, Company 
(Note that an additional field is required in addition to Name fields; the 
Company field option meets this requirement) 

The dialog box should appear similar to the figure below: 
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93. Click Save. 

 To finish with Forms and Fields: 

94. In the current UI, click Administration > Expense Admin > Forms and 
Fields (left menu) 
- or -  
In the enhanced UI, click Administration > Expense > Forms and Fields. 

95. In the Form Type list, click Expense Attendee. 

 

96. Select the attendee form you assigned to the SYSEMP attendee type and click 
Modify Form. 

97. Ensure that the Created By (Private List) check box is not selected. 

• IMPORTANT: SYSEMP with Non Employees 

The Employee (SYSEMP) attendee type is used to automatically add employees to a 
client's attendee list – so users can quickly find other employee attendees. In some 
cases, company requirements drive the creation of user accounts for people who are 
not employees of the company, such as contractors.  

Due to regulatory and client requirements, there must be a way to clearly define the 
precise and correct attendee type for the user who is not an employee. The solution 
is to use a profile (employee) field to indicate which users are not employees. Users 
who are not employees will: 

• Not be automatically added to the Employee Attendee type 

• Not be searchable via the Employee attendee type 

• Not be automatically added as an attendee for an expense type configured to 
do so for employees 

• Configuration – Client 
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Clients interested in using this feature must contact Concur Client Support for 
assistance. Concur will add the Is Non Employee field to the profile (employee 
form) as described below. 

Then, the client can: 

• Use its own internal resources to determine which Expense users are non-
employees 

• Access User Administration to select (enable) the Is Non Employee field for 
each non-employee 

NOTE: The Is Non Employee field is not available in the user import. 

• Configuration – Concur 

Concur will follow the configuration/activation steps noted below. The process is to 
add the new Is Non Employee field to the employee form and then make the field 
modifiable by the Employee Administrator. 

98. In the current UI, click Administration > Expense Admin > Forms and 
Fields (left menu). 
- or - 
In the enhanced UI, click Administration > Expense > Forms and Fields. 

99. In the Form Type list, click Employee. 

100. Click the Form Fields tab. 

101. Click Add Fields. 

 

102. Select the Is Non Employee field. 

103. Click Add Fields. The Is Non Employee field now appears on the 
employee form. 
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104. To ensure that the field is modifiable by the Employee Admin, double-
click the Is Non Employee field. The Modify Form Fields window appears. 

 

105. In the Employee Administrator Role list, click Modify. 

106. Click Save. 

• Step 7: Create Attendee Audit Rules 

You can create audit rules that allow you to flag attendees, for example, for: 

• The total amount spent, per expense type, on any attendee, totaled either 
company-wide or by the current employee 

• The frequency (per month, quarter, or year) at which any individual has been 
named an attendee, either company-wide or by the current employee  

Amount and frequency totals that apply to the current employee are stored with the 
expense entry. Amount and frequency totals that apply to the entire company are 
stored with the expense entry and the attendee record. 

 Refer to the Expense: Audit Rules Setup Guide. 

• Step 8: Configure for Personal Attendee Import 

In order to activate this feature (and configure the required template), the 
administrator must have the Expense Configuration Administrator (Restricted) or the 
unrestricted Expense Configuration Administrator role assigned in Expense. 

• Overview: Personal Import 

These are the steps in the configuration process: 

Part 1: Initiate the process to generate a basic template worksheet. 
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Part 2: Edit the template, for example, to account for list data. 

Part 3: Upload the completed worksheet. 

Once the completed worksheet is uploaded, the Import button appears in the 
Attendees section of the New Expense (or Expense) tab, ready to be used. 

• Procedure: Part 1 – Generate the Basic Template 

 To generate the base template: 

107. Click Administration > Expense (on the sub-menu). 

NOTE: Depending on your permissions, the page may appear immediately 
after you click Administration. 

108. Click Attendee Import Templates. The Excel Templates For 
Attendee Import page appears. 

 

109. Select the desired language (the language in which the template will 
be generated), and click Generate Base Template. 

110. Take the necessary steps (depending on browser) to save the template 
to your local computer or network. 

111. Repeat this process for each required language. 

• Review the Template Worksheet 
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Open the worksheet file.  

 

Each Excel file has at least one worksheet (tab). The first sheet is named Attendees. 
Any other sheets that may appear contain drop-list data.  

On the Attendees sheet: 

• Row 1 shows the field codes 

• Row 2 shows the client-defined field names 

• Row 3 - 65,536 are the rows in which the user will type 

• Procedure: Part 2 – Edit the Worksheet 

• Row 1 (Field Codes) 

Do not edit any of these cells. If any of these cells are changed, the import will 
fail. During the configuration process, you will use these field codes and any 
additional worksheets to create the drop-list fields.  

• Row 2 (Field Names) 

These are the field names (column headers) that will display to the user. The main 
editing task involves required fields. 

 To work with row 2 (field names): 

You must: 

112. Access Expense and view the Attendees section of the New Expense 
(or Expense) tab to see which of the attendee fields are required. 

113. Mark the required fields. You can solve the problem as simply or as 
intricately as you want. Two suggestions are: 

♦ If you are not concerned about users using the optional fields, then hide 
the optional columns so only the required columns appear. Instruct users 
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to complete all fields. 
- or - 

♦ Edit the labels of the required fields to include "REQUIRED" 
Example: REQUIRED Last Name 

• Row 3 through 65536 (Data) 

These are the cells in which the user will type or select (drop-list) attendee data. The 
editing tasks involve list data and other field formatting. 

NOTE: Any change/edit you make in any column must apply to each row 
from Row 3 to Row 65536. This ensures that – no matter how many rows 
the user wants to use – he/she is always using a formatted row. 

 To manage the list data: 

114. Review the list data shown on the other worksheets (tabs), if any. The 
name on the worksheet tab matches the field code (Row 1).  

This template worksheet provides only the first 100 items for each list. So: 

♦ If less than 100 items appear for a list, then assume that all available list 
items are provided for that list.  

♦ If exactly 100 items appear, then assume that there are more list items. 
You can: 

• Add the remaining list items by typing them into the Excel sheet 
manually, or 

• Submit a service request to Concur Client Support to obtain a full 
copy of the list. The information you receive can then be copied 
and pasted into Excel. 

NOTE: If you change attendee-related list data frequently in Expense, you 
must also update this worksheet for each change. Another option is 
to set this field as a text field, with a comment instructing users 
how to correctly enter the appropriate option. 

115. Configure these rows with drop-lists. Instructions are provided in 
Create Drop Lists in Excel.  

 To deal with other formatting:  

It is not likely that the template will require other formatting (such as numeric only 
or field length restrictions) in the attendee fields. However, to be sure:  

116. Access Expense to identify any other applicable field formatting. 

117. Format the worksheet to match those formatting requirements. 
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! IMPORTANT: For these fields, you can solve the problem as simply or as 
intricately as you want but do not enter text in these cells.  

• Final Editing Step 

 To hide the field codes and "list" sheets: 

When all formatting is complete, hide – do not remove – the field codes (Row 1) and 
the sheets (tabs) that contain the list data.  

118. To hide the field codes (Row 1): 

 
♦ Select the first row. 

♦ On the Home tab, click Format > Hide & Unhide > Hide Rows. 

119. To hide the worksheet(s) with the list data: 

 
♦ Select all sheets except the first one (Attendees). 

♦ On the Home tab, click Format > Hide & Unhide > Hide Sheet. 
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Tip: Just before saving for the last time, click in cell A3 and then save. The next 
time the worksheet is opened, A3 will be 
selected. Since A3 is likely a list, the down 
pointing arrow appears, making it easy for 
the user to identify this field as a drop-list. 

• Procedure: Part 3 – 
Upload the Customized Worksheet 

 To upload the sheet: 

120. Return to the Excel Templates For Attendee Import page as 
described previously. 

121. Click Upload Template. 

 

122. Click Browse (or Choose File depending on browser) and locate the 
customized worksheet. 

NOTE: If you have multiple languages, you must first select the language in 
the drop list and then upload the template for that language.   

 

123. Click Upload Template. The new template appears. 
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At this point, the Import button will be available for users in the Attendees section 
of the New Expense (or Expense) tab for that language. 

 

Follow these same steps for all templates for all desired languages. 

• Procedure: Create Drop Lists in Excel 

This information applies to Microsoft Excel 2010. If you have a different version of 
Excel, search for "drop-down list" in Excel's online help. 

 To add the drop-list for the list data: 

124. Click the sheet (tab) that contains the list data, in this case, 
AtnTypeKey. 

125. Select the list data. 

 



Page | 9 1         T e a m W o r k s  T r a v e l  &  E x p e n s e  S y s t e m         Version Date: 09/22/2015                         
              A t t e nd e e  A d m in i s t r a t i o n                  
 

126. In the name box, type a range name, such as AttType, and press 
Enter. 

 

127. On the Attendees tab, click cell A3. 

128. On the menu, select Data > Data Validation. The Data Validation 
dialog box appears. 

 
♦ In Allow, select List. 

♦ In Source, type =<range name>. In this case, =AttType.  
Hint: Don't forget. The range name starts with = 

♦ Click OK. 

129. Copy A3 to cell A4 through A65536.  
 
Tip: To copy from A3 to the end of the column: 

• Click in A3 

• Copy 

• Click in A4 

• Press CTRL + SHIFT + down arrow 

• Paste 

130. Complete these same steps for all lists. 
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• Step 9: Import a List of Attendees 

You can import a list of attendees for your company, for example, your company's 
client list or list of employees. This way, they appear in the Attendees list so users do 
not have to enter them manually (and perhaps inconsistently). You can also use the 
import feature to change attendee information or delete attendees. 

 To import a list of attendees, refer to the Attendee Import chapter in the 
Expense – Import and Extract File Specifications. 

• IMPORTANT! Using the Attendee Import on an Existing System 

If you are planning to use the attendee import on an existing system (already has 
attendees), refer to Implementing the Attendee Import on an Existing System - Tips 
and Hints. 

• External ID - Required for Imported Changes and Deletions 

The External ID is required in order to make changes to attendees (edit or delete) 
via the import. In most cases, the External ID is a company-generated unique 
identifier, which is imported with the initial import of attendees. However, for 
attendees who are manually entered by Expense users, there likely is no External ID. 
Without that information, you cannot change or remove those attendees via the 
import. 

To solve this problem, you can have the system auto-generate an External ID for 
each attendee so that the External ID will never be blank.  

• Configuration 

To activate this feature, select Generate an External ID when a new attendee is 
created by a user on the Settings tab of the Attendees page. 

 

• Extract the External IDs 
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Then, to obtain the External IDs for all attendees (so you can use them in an 
import), collect them from the Standard Attendee Detail Extract: 

• If the Standard Attendee Detail Extract is already turned on for your 
company, the file will be available with your other extract files. 

• If not, contact Concur Client Support to have it turned on. 

 Refer to the Standard Attendee Detail Extract chapter in the Expense – 
Import and Extract File Specifications. 

Section 7:  Retain Attendee History with the Associated Expense 
Entry 

• Overview 

By default, historical attendee information is not captured; only the current attendee 
information (master record) is available. Using the configuration steps described 
here, the point-in-time attendee information can be saved with the associated 
expense entry.  

Attendee information (such as name or title) can change over time. With this 
feature, once the attendee is attached to an expense entry, that attendee 
information is stored and not allowed to be changed when the master record 
changes. 

• Procedure 

To enable this feature (This process is completed by Concur): 

131. Access the entity in HMC. 

132. On the Settings page, set Enable attendee history to Yes. 
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Section 8:  Implementing the Attendee Import on an Existing 
System - Tips and Hints 

• Changing from a User-Entered List to a Managed List of 
Attendees 

In existing systems (not yet using the import), it is likely that each Expense user 
entered a record for every attendee the user wanted to use, including 
himself/herself. This means that it is highly likely that many of the attendees you 
want to import from another application already exist within the system – and many 
will exist multiple times.  

To start fresh with a new list of attendees from the imported list, follow these steps: 
 

Step 
# 

Description Where to find 
more 
information 

1 Define the name of the attendee type for this list. Attendee 
type names must be unique.  
Tip: If you want the same name as the existing attendee 
type, we recommend that you rename the existing attendee 
type and then create a new attendee type with the desired 
name. 

Procedure: 
Configuring 
Attendee Types in 
this guide 

2 Determine if users will be allowed to add new attendees to 
the attendee type list. If you want to control this list, you 
may wish to turn off the users' ability to add new attendees. 

3 Create the import file and import the list of attendees. Attendee Import 
chapter of 
Expense – Import 
and Extract File 
Specifications 

4 Inactivate the old attendee type. This will remove all 
attendees of this type from all users' lists of attendees, 
though the information will still be viewable on expenses 
using those attendees. 

Procedure: 
Configuring 
Attendee Types in 
this guide 

• Changing Employees as Attendees to a Managed List of 
Attendees 

There are two employee-related attendee types: 

• Employee: In older versions, each Expense user had to enter a record for 
every employee attendee the user wanted to use, including himself/herself. 
This means that it is highly likely that many of the employee attendees 
already exist multiple times within the system.  

• This Employee: The system will automatically generate a record for each 
Expense user but only once the employee takes one of these actions: 

♦ The employee opens a new expense form where the employee is required 
to be added by default. 
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♦ The employee completes a 'This employee' attendee type search from the 
Attendee section of the New Expense (or Expense) tab or from profile. 

♦ The employee completes a quick search or a favorite search from the 
Attendee section of the New Expense (or Expense) tab or from profile.   

To make this list a comprehensive and usable list of employees that can be shared 
by all for use on expenses, follow these steps: 
 

Step 
# 

Description Where to find 
more 
information 

1 Create an import file containing data for the employee 
attendee records and import the list. This will provide 
records for those employees who have not yet accessed the 
Attendee section as well as provide additional details in 
each employee attendee record. 
When creating the import file: 
• The External ID for these records must be the Employee 

ID that appears in Expense. 
• The Attendee Type Code must be SYSEMP. 

NOTE: Consider importing all employees who will be used 
as attendees – not only those who use Expense. This will 
provide a comprehensive list of employee attendees for your 
Expense users to search and select from. Then, if the 
imported employees who are not yet Expense users become 
users in the future, the Employee ID will be used to link the 
attendee-related information to the correct user. 

Attendee Import 
chapter of 
Expense – Import 
and Extract File 
Specifications 

2 Configure the This Employee attendee type:  

• Change the name if desired.  
Attendee type names must be unique. If you want the 
same name as the existing Employee attendee type, 
then you must rename the existing Employee attendee 
type first and then change This Employee to Employee. 

Procedure: 
Configuring 
Attendee Types in 
this guide 

• Configure the This Employee attendee type as a shared 
list by removing the Created By field in the duplicate 
check field. 

Private vs. Shared 
Attendee Lists and 
Procedure: 
Configuring 
Attendee Forms 
and Fields in this 
guide 

3 Inactivate the old Employee attendee type. This will remove 
all attendees of this type from all users' lists of attendees, 
though the information will still be viewable on expenses 
using those attendees. Users creating new expenses will 
search for and use employee attendee records under the 
new This Employee attendee type. 

Procedure: 
Configuring 
Attendee Types in 
this guide 
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Step 
# 

Description Where to find 
more 
information 

4 Change the new Employee attendee type to a shared list. 
• Change the form fields for search - clear the Created By 

(Private List) check box 

 
• Edit the duplicate check - clear the Created By 

(Private List) check box 

 

Private vs. Shared 
Attendee Lists in 
this guide 
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